Installing and Customizing Lotus eSuite WorkPlace 1.5 for IBM Network Stations

January 1999
Before using this information and the product it supports, be sure to read the general information in Appendix C, “Special Notices” on page 169.
3.1.4 Starting the Network Station Manager .............................................. 25
3.1.5 Configuring the Domain Name Server Data ...................................... 25
3.1.6 Configuring the Desktop in IBM Network Station Manager ............... 27
3.1.7 Defining a Time Zone Environment Variable ................................. 29
3.1.8 Enabling eSuite Colors ................................................................. 31
3.1.9 Selecting a User’s Group for eSuite Users .................................. 32
3.2 Configuring eSuite 1.5 Using eSuite WorkPlace Administrator .......... 34
  3.2.1 What Is eSuite WorkPlace Administrator? ..................................... 34
  3.2.2 Accessing/Starting the eSuite WorkPlace Administrator ................. 35
  3.2.3 Giving WorkPlace Administrator Access to Other Users .................. 40
  3.2.4 Java Security ............................................................................. 40
  3.2.5 Adding Users to the eSuite Registry ....................................... 42
  3.2.6 Multiple Servers Environment .................................................. 49

Chapter 4. Customizing eSuite Applications ............................................ 51
  4.1 Customizing the eSuite WorkPlace Desktop ..................................... 53
  4.2 Customizing the Browser Task ....................................................... 55
  4.3 Customizing the Mail Task .............................................................. 58
    4.3.1 Defining Users on the Mail Server ............................................. 62
  4.4 Customizing LDAP ........................................................................ 67
  4.5 Customizing Network Station Native Applications ........................... 71
    4.5.1 Customizing a Start the 3270 Emulator Task ......................... 72
    4.5.2 Adding a Lock Screen Native Command Task ....................... 77
    4.5.3 Adding a Telnet Task .......................................................... 87
    4.5.4 Adding a Java Applet Task ................................................... 90
  4.6 Customizing eSuite Application Services ...................................... 93
    4.6.1 Limitations ............................................................................ 93
    4.6.2 eSuite Application Services Installation ................................ 93
    4.6.3 Customization Steps .................................................................. 94
    4.6.4 Setting the Spelling Dictionary .......................................... 97
    4.6.5 Customizing the Default Filenames .................................... 98

Chapter 5. Using The Lotus eSuite WorkPlace 1.5 Applications ................ 101
  5.1 Starting the eSuite WorkPlace Desktop ...................................... 101
    5.1.1 Processing of the esuite.nsl File ........................................... 101
    5.1.2 Desktop Startup Duration .................................................. 102
  5.2 Using the Web Tasks ..................................................................... 104
  5.3 Using the Work Files Tasks ........................................................... 106
  5.4 Using the Calendar Task ................................................................ 108
  5.5 Using the Calculating Task ............................................................ 109
  5.6 Using the Presenting Task ............................................................. 110
  5.7 Using the Writing Tasks ................................................................. 111
  5.8 Using the Address Book Task ....................................................... 112
  5.9 Using the Mailbox Tasks ............................................................... 113
  5.10 Using Network Station Native Applications ................................ 117

Chapter 6. Basic Problem Determination ................................................ 119
  6.1 Troubleshooting Domain Name Server Configuration ......................... 119
    6.1.1 DNS Configuration on the Server ..................................... 119
    6.1.2 DHCP DNS Configuration .................................................. 121
    6.1.3 Network Station’s DNS Configuration ................................ 123
    6.1.4 Displaying the IP Routing Table ....................................... 125
    6.1.5 Troubleshooting AS/400 Problems ................................... 126
  6.2 Sample Message Logs (Startup and Shutdown) .............................. 127
<table>
<thead>
<tr>
<th>Figures</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Installation Initial Panel</td>
<td>9</td>
</tr>
<tr>
<td>2. Destination Directory - Lotus eSuite WorkPlace Installation</td>
<td>10</td>
</tr>
<tr>
<td>3. Previous Version Information Panel</td>
<td>10</td>
</tr>
<tr>
<td>4. NT Services for Lotus eSuite WorkPlace</td>
<td>12</td>
</tr>
<tr>
<td>5. Directives Added to Domino Go Webserver Configuration File</td>
<td>12</td>
</tr>
<tr>
<td>6. eSuite Virtual Directories Added to IIS</td>
<td>13</td>
</tr>
<tr>
<td>7. Creating a New Group in Windows NT</td>
<td>14</td>
</tr>
<tr>
<td>8. Adding Members to the esuite Group</td>
<td>15</td>
</tr>
<tr>
<td>9. Groups in eSuite vs. NSM vs. Server</td>
<td>24</td>
</tr>
<tr>
<td>10. Selecting a User’s Group in NSM</td>
<td>25</td>
</tr>
<tr>
<td>11. DNS Configuration in IBM Network Station Manager</td>
<td>26</td>
</tr>
<tr>
<td>12. Choosing a Source for the DNS Configuration Data</td>
<td>26</td>
</tr>
<tr>
<td>13. Setting Group Defaults</td>
<td>28</td>
</tr>
<tr>
<td>14. Desktop and Menu Bar Options</td>
<td>28</td>
</tr>
<tr>
<td>15. Setting an Environment Variable</td>
<td>29</td>
</tr>
<tr>
<td>16. Setting the TZ Environment Variable</td>
<td>29</td>
</tr>
<tr>
<td>17. Getting the Time from the Time Server</td>
<td>30</td>
</tr>
<tr>
<td>18. Time Server Configuration Panel - Windows NT</td>
<td>31</td>
</tr>
<tr>
<td>19. Setting the eSuite Color Palette</td>
<td>32</td>
</tr>
<tr>
<td>20. Selecting a Users Group</td>
<td>33</td>
</tr>
<tr>
<td>21. Choosing a Group for a User</td>
<td>33</td>
</tr>
<tr>
<td>22. The eSuite WorkPlace Administrator and Network Station Manager</td>
<td>35</td>
</tr>
<tr>
<td>23. Starting the WorkPlace Administrator on the Server</td>
<td>36</td>
</tr>
<tr>
<td>24. Properties for the WorkPlace Administrator Shortcut</td>
<td>36</td>
</tr>
<tr>
<td>25. Starting the WorkPlace Administrator from the eSuite WorkPlace Desktop</td>
<td>37</td>
</tr>
<tr>
<td>26. Starting the WorkPlace Administrator from the Network Station Manager</td>
<td>38</td>
</tr>
<tr>
<td>27. Lotus eSuite WorkPlace 1.5 Administrator Main Configuration Panel</td>
<td>39</td>
</tr>
<tr>
<td>28. eSuite 1.5 versus eSuite 1.0 WorkPlace Administrator</td>
<td>40</td>
</tr>
<tr>
<td>29. Java Security Panel</td>
<td>41</td>
</tr>
<tr>
<td>30. Certificate for Lotus Development Corporation</td>
<td>42</td>
</tr>
<tr>
<td>31. The Import Users Function</td>
<td>44</td>
</tr>
<tr>
<td>32. Importing Groups Example</td>
<td>45</td>
</tr>
<tr>
<td>33. Synchronize Database Panel</td>
<td>46</td>
</tr>
<tr>
<td>34. Local Groups vs. Global Groups</td>
<td>47</td>
</tr>
<tr>
<td>35. Adding a Domain Global Group to a Local Group</td>
<td>48</td>
</tr>
<tr>
<td>36. The Customize Software Selection Panel</td>
<td>51</td>
</tr>
<tr>
<td>37. Customizing eSuite Software</td>
<td>52</td>
</tr>
<tr>
<td>38. The Add Category Panel</td>
<td>54</td>
</tr>
<tr>
<td>39. The Categories Tab of the WorkPlace Administrator</td>
<td>54</td>
</tr>
<tr>
<td>40. The Proxy Configuration Panel in WorkPlace Administrator</td>
<td>56</td>
</tr>
<tr>
<td>41. Using a Proxy</td>
<td>57</td>
</tr>
<tr>
<td>42. Socks Server Note from the Readme File</td>
<td>57</td>
</tr>
<tr>
<td>43. The Customize Software Selection Panel</td>
<td>58</td>
</tr>
<tr>
<td>44. The Customize Mail Session Manager Panel</td>
<td>59</td>
</tr>
<tr>
<td>45. Customize Mail for a User</td>
<td>60</td>
</tr>
<tr>
<td>46. User Prompt Panel - Mail Task</td>
<td>62</td>
</tr>
<tr>
<td>47. Microsoft Exchange Administrator Panel</td>
<td>63</td>
</tr>
<tr>
<td>48. New Mailbox Panel in Microsoft Exchange Server</td>
<td>63</td>
</tr>
<tr>
<td>49. Accessing the Server Administration Function in Notes</td>
<td>64</td>
</tr>
<tr>
<td>50. Notes Administration Panel</td>
<td>65</td>
</tr>
</tbody>
</table>
51. The Register Person Panel ................................. 65
52. Register Person Data ....................................... 66
53. Mary Jones in the Notes Address Book ...................... 66
54. Editing the Mary Jones Address Book Entry ................. 67
55. The Customize Software Selection Panel ..................... 68
56. The LDAP Customization Panel .............................. 68
57. The LDAP Customization Panels ............................. 70
58. The Network Station Category of Tasks ...................... 71
59. Add Task Panel ............................................. 72
60. The Set Task Properties Panel .............................. 73
61. Select a WorkPlace Category for the New Task ............... 74
62. The Categories Panel Showing the New Task ................. 75
63. Assigning a Task to a User .................................. 76
64. The New MyNew3270 Task .................................. 76
65. The Software Tab of the WorkPlace Administrator ............ 78
66. The Add Software Panel ..................................... 79
67. The Lock Screen Software After Being Added ................ 80
68. The Tasks Tab of the Administrator WorkPlace ............... 81
69. The Add Task Panel ......................................... 82
70. Assigning a Task to a Category ................................ 83
71. The Categories Tab ........................................... 84
72. Assigning a Task to a Group .................................. 85
73. The Lock Screen Task in the Test Applications Category .... 86
74. The Lock Screen Function ....................................... 86
75. Adding a Telnet Session Software Entry ....................... 88
76. Add Task (Telnet) ............................................. 89
77. Add Software (Java Applet) ................................... 90
78. The Software Tab after Adding Java Clock .................... 91
79. The Add Task Panel for the Java Clock Example ............... 92
80. Executing the Java Clock Sample Applet from eSuite ........... 93
81. eSuite Application Services Startup Messages ................ 94
82. The Software Panel - Customizing eSuite Application Services .... 95
83. The Customize Software for Group Panel ....................... 96
84. Entering the Path to the IOR File .............................. 96
85. IOR File Information after Customization ..................... 97
86. The Writing Task Edit Options ................................ 97
87. Setting the Spelling Dictionary ............................... 98
88. Using the Spell Check Function ................................ 98
89. The User's Home Directory .................................... 99
90. The messageSourceMgr Customization Panel .................. 99
91. the eventSourceMgr Customization Panel ..................... 99
92. The addressSourceMgr Customization Panel ................. 100
93. The esuite.nsl File Contents ................................ 101
94. The Lotus eSuite WorkPlace Main Desktop .................... 103
95. Controls on the eSuite Desktop ................................ 104
96. The Lotus eSuite WorkPlace Browser Application ............ 105
97. Some of the Web Browser Controls ............................ 105
98. The Work Files Task ......................................... 106
99. The Work Files Functions ..................................... 107
100. User Ariane’s Home Directory ................................ 107
101. The Calendar Task ........................................... 108
102. The Calculating (Spreadsheet) Task .......................... 109
103. Spreadsheet and Cell Properties Choices ..................... 109
Tables

1. Supported Viewers and Filters ................................. 3
2. Summary of Installation and Configuration Steps for eSuite 1.5 .......... 4
3. Summary of Installation and Configuration Steps for eSuite 1.0 ........ 131
Preface

This redbook is a short introduction to the Lotus eSuite WorkPlace 1.5 product, which can be installed on a Network Station Manager 3.1 Server to be used by IBM Network Station users.

It illustrates the process of installing the eSuite WorkPlace 1.5 product on a Windows NT server, but also the process of configuring and customizing eSuite, which is applicable to any platform. It also provides a very brief introduction to the different applications available with the eSuite WorkPlace and how to do basic problem determination.

This book is not meant as an in-depth document that replaces the product documentation but rather as a brief illustrated implementation guide and tutorial that supplements the existing documentation. Its main objective is to help the reader understand the elements of the eSuite WorkPlace that may need some customization by providing explanations and insights into the each customization task and also help the reader to perform these customization steps by providing illustrated examples of common customization tasks.

The instructions applicable to the previous release of eSuite WorkPlace (Release 1.0 and NSM 3.0) have also been included in Appendix A, “Installing/Configuring eSuite Release 1.0” on page 131 for the sake of completeness and for users that might still require to use that particular version until they migrate to Release 1.5.

The Author

This document was produced by a member of the IBM International Technical Support Organization in Raleigh N.C.

Claude Bechard is a Senior Technical Marketing Support Representative at the International Technical Support Organization, Raleigh. He joined the ITSO seven years ago and has since written several redbooks on SNA communications and IBM Communications Server products. His responsibility in the last 18 months has been to produce redbooks on the IBM Network Station and the Windows NT platform. He is an IBM Canada employee, with 29 years of service with IBM, and holds a degree in Mechanical and Industrial Engineering from the University of Montreal.

We wish to express our appreciation to the members of the development team who have given us their support and cooperation by patiently answering many questions and by reviewing this document.

Comments Welcome

Your comments are important to us!

We want our redbooks to be as helpful as possible. Please send us your comments about this or other redbooks in one of the following ways:
• Fax the evaluation form found in “ITSO Redbook Evaluation” on page 181 to the fax number shown on the form.

• Use the electronic evaluation form found on the Redbooks Web sites:
  
  For Internet users  http://www.redbooks.ibm.com
  For IBM Intranet users  http://w3.itso.ibm.com

• Send us a note at the following address:

  redbook@us.ibm.com
Chapter 1. Introduction

This document provides a brief introduction to the Lotus eSuite WorkPlace 1.5 installation, configuration and customization tasks. These tasks are first summarized in a brief checklist that can be used by users who require only a brief explanation.

This is followed by detailed and illustrated examples of each of the installation, configuration and customization steps. All examples are performed using the Windows NT platform; however, most of the configuration and customization steps are applicable to all platforms.

The installation steps for other platforms such as AIX, OS/400 and OS/390 have been reproduced in this document as a straight copy from the readme files, mainly as a matter of convenience for the reader, but these instructions have not been tested; only the Windows NT readme instructions have actually been used by the author.

The focus of the document is to provide additional details, explanations and examples for each of the important configuration and customization tasks, thereby raising the level of understanding concerning these tasks.

This document is not a detailed user guide providing instructions and examples on how to use each of the eSuite applications; these operational details can be found in the online documentation.

1.1 Audience

The primary target audience for this document is the user who is already familiar with the IBM Network Station and who understands how to use the IBM Network Station Manager application to configure the IBM Network Stations, but who might not be familiar with Lotus eSuite WorkPlace.

On the other hand, if you are not familiar with how to install a server to support Network Stations, but you have been provided with an environment where the server is already installed and configured, and all you want is to add Lotus eSuite WorkPlace to that existing environment, the instructions in this document should be sufficient to guide you to accomplish that task.

Finally, if you are not already familiar with the installation and configuration of a server to support a network of IBM Network Stations and need to install that environment first, we suggest that you consult the Network Station Manager product publication and the redbooks relevant to that topic before you proceed.

Some of the suggested publications that may be useful are:

- IBM Network Station Manager Installation and Use, SC41-0664
- IBM Network Station Manager Release 3 Guide for Windows NT, SG24-5221
- AS/400 - IBM Network Station - Getting Started, SG24-2153
- IBM Network Station - RS/6000 Notebook, SG24-2016
- S/390 - IBM Network Station - Getting Started, SG24-4954
1.2 What Is Lotus eSuite WorkPlace?

Lotus eSuite WorkPlace is a suite of applications that are Java versions of some popular Windows-based applications such as a word processor, a Web browser, a spreadsheet application, a graphics application, calendar, mail, etc.

Without eSuite, access to Windows applications such as these from an IBM Network Station is done through the use of a multi-user Windows NT server such as WinFrame or MetaFrame, where the application actually resides and executes on the Windows NT server machine while input and output is done from the Network Station's keyboard and monitor.

Since the Lotus eSuite WorkPlace applications are coded in Java, they can now execute natively on the IBM Network Station as Java applets and they do not require the use of a Windows application server.

Typically, the eSuite WorkPlace applications are meant to provide a simpler and more user-friendly operational environment than the one provided by their Windows counterpart, so they provide a subset of the functions available in the Windows version of these same applications and are targeted at typical end users rather than power users.

1.3 What Is New in Release 1.5?

Release 1.5 of Lotus eSuite WorkPlace provides the following enhancements:

- The eSuite WorkPlace Administrator functions can now be accessed from within Network Station Manager. This provides the administrator with a single interface for configuring both the Network Station settings and the eSuite WorkPlace settings.

  Note: If the NC Navigator on the Network Station is used to access NSM, this function is not available because it is not supported by NC Navigator. In other words, the browser must be running on a PC in order to use the eSuite WorkPlace Administrator from within NSM.

  The graphical interface of the eSuite WorkPlace Administrator has changed slightly from the previous release, but the fields and structure to configure the eSuite Registry are basically the same.

  Note that the eSuite WorkPlace Administrator is still accessible directly from the server (Windows NT and AIX only) and also from the eSuite WorkPlace desktop, as it was in Release 1.0.

- An important new function (and difference with the previous release) is the fact that users and groups are now created, added, deleted, and users assigned to groups, only on the server database. In other words, users can no longer be created using the eSuite WorkPlace Administrator.

  Instead, an import and synchronization function is available in the eSuite WorkPlace Administrator to import the user definitions from the server database; this facilitates maintaining a single set of user and group definitions that is used in both NSM and the eSuite Registry. Users are also automatically added to the eSuite Registry the first time that they logon if they are defined as eSuite users in NSM (that is, as requiring the eSuite desktop).
• Support for launching native X applications from within the eSuite WorkPlace, such as the 3270 emulator, 5250 emulator and the NC Navigator browser. These tasks are part of a new category on the eSuite desktop called Network Station and they can be launched directly from the eSuite WorkPlace desktop. Other tasks can also be added to perform functions such as Lock Screen, start a Telnet session, start a Java applet, etc.

• Release 1.5 of eSuite is Year 2000 ready. Note that the previous release of eSuite is not Year 2000 ready.

• A Points Mode facility was added to the Presentation Graphics task.

• A Cross Applet Clipboard function allowing Cut and Paste functions between the various eSuite tasks such as the word processor, calendar, mail, spreadsheet and presentation graphics, etc.

The above enhancements are part of the base eSuite WorkPlace 1.5 code. There are additional enhancements provided to eSuite WorkPlace desktop users when a separate additional product called Lotus Application Services is installed on a Windows NT server.

This product can only be installed on a Windows NT server but can be accessed by any eSuite desktop user no matter what platform the desktop is supplied from.

The additional enhancements provided by the Lotus Application Services product are:

• A spell checking function, available for the word processing, mail, spreadsheet and presentation graphics tasks.

• An undo function, available for the word processing, mail, spreadsheet and presentation graphics tasks. The spell check function must be installed on an NT server for this function to be available.

• The following file viewers and file filters are available for eSuite desktop tasks to work with non-eSuite files:

<table>
<thead>
<tr>
<th>Supported File Formats</th>
<th>Viewers</th>
<th>Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus 1-2-3 Spreadsheet</td>
<td>WK3, WK4, 123</td>
<td>WK4</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XLS, XLW</td>
<td>XLS</td>
</tr>
<tr>
<td>Quattro Pro Spreadsheet</td>
<td>WQ1, WB1, WB2</td>
<td></td>
</tr>
<tr>
<td>Lotus WordPro Document</td>
<td>LWP</td>
<td>LWP</td>
</tr>
<tr>
<td>Microsoft Word Document</td>
<td>DOC</td>
<td>DOC</td>
</tr>
<tr>
<td>WordPerfect Document</td>
<td>WPD</td>
<td></td>
</tr>
<tr>
<td>Lotus AMIPRO Document</td>
<td>SAM</td>
<td></td>
</tr>
<tr>
<td>Rich Text Format Document</td>
<td>RTF</td>
<td></td>
</tr>
<tr>
<td>DCA/RFT Document</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comma Separated Values (Spreadsheet)</td>
<td>CSV</td>
<td></td>
</tr>
</tbody>
</table>
1.4 Summary of Installation and Configuration Steps

For those who require only a very brief checklist, with minimal instructions, we provide here a summary table where each step can be marked as complete after it is performed.

Table 2. Summary of Installation and Configuration Steps for eSuite 1.5

<table>
<thead>
<tr>
<th>Check</th>
<th>Step</th>
<th>Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On the server</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Read the Readme file pertinent for your platform.</td>
<td>The readme files contain the latest instructions, based on the version that you are using, and should always be consulted first.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Verify the prerequisites.</td>
<td>The best way is to consult the readme file for your platform.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Install eSuite on the server.</td>
<td>Insert the CD and follow instructions, which are usually simple and straightforward. See details in Chapter 2, “Installing Lotus eSuite WorkPlace 1.5” on page 7 if required.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>This step may be optional. Create a group on the server (use any name you wish, for example esuite).</td>
<td>This group is to be used for all eSuite users. <strong>Note</strong>: If all Network Station users are also all eSuite users, this step is optional and you can configure all settings at the system defaults level in NSM instead of using a specific group.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Create a user account called admin on the server.</td>
<td>This user name is pre-defined in the WorkPlace Administrator and is required in order to initially log on to the eSuite WorkPlace Administrator later in the configuration process. For AIX, this is not required because a user called root is also pre-defined in the WorkPlace Administrator.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Make the user called admin a member of the NSMUser and NSMAdmin groups on the server. These group names may be applicable to Windows NT only.</td>
<td>This is to ensure that this user can log on to the Network Station Manager and use the WorkPlace Administrator from within NSM.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Create other eSuite users, as needed and add them to the NSMUser (in Windows NT) group (as well as to the group you created in step 4 if you are using a separate group for eSuite users).</td>
<td>Users logging on to a Network Station must be members of the NSMUser group. These users will be imported into the eSuite Registry using the WorkPlace Administrator.</td>
<td></td>
</tr>
</tbody>
</table>

**Using Network Station Manager**

<table>
<thead>
<tr>
<th>Check</th>
<th>Step</th>
<th>Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Start Network Station Manager.</td>
<td>In your browser, use URL = //server/networkstation/admin where server is the IP host name or address of the server where NSM resides.</td>
<td></td>
</tr>
<tr>
<td>Check</td>
<td>Step</td>
<td>Action</td>
<td>Comments</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td>9</td>
<td>Configure the DNS information for all stations (assuming that this has not already been done).</td>
<td>In NSM, select <strong>Hardware =&gt; Workstations =&gt; System Defaults</strong>, click on <strong>Next</strong>, then scroll down to Domain Name Server and select one of the two buttons, dependent on whether you use DHCP or not, and click on <strong>Finish</strong>.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Configure the Network Station to bring up the eSuite WorkPlace desktop.</td>
<td>In NSM, select <strong>Startup =&gt; Menus</strong>, select <strong>System Defaults</strong> (or enter the group name you created in step 4 in Group Defaults), click <strong>Next</strong>, and in the section called Desktop and Menu Bar Options, use the Desktop Style drop-down list, select <strong>Lotus eSuite WorkPlace with menu bar</strong>, and click on <strong>Finish</strong>.</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Configure the time zone (TZ) environment variable.</td>
<td>In NSM, select <strong>Startup =&gt; Environment Variables</strong>, then <strong>System Defaults</strong> (or enter the group name you created in step 4 in Group Defaults), click <strong>Next</strong>, in the field called Environment variable, enter the value <strong>TZ</strong>, and in the Value field, enter <strong>EST</strong> (for Eastern Standard Time) or whatever the correct value is for your geographical location and click on <strong>Finish</strong>.</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Configure the eSuite colors palette.</td>
<td>In the NSM Setup Tasks on the left, select <strong>Hardware =&gt; Workstations</strong>. Select <strong>System Defaults</strong> (or enter the group name you created in step 4 in Group Defaults). Click on <strong>Next</strong> and scroll down to the Monitor Settings section. At the bottom of the section, use the drop-down list Enable eSuite colors (web palette) and select <strong>Yes</strong>.</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>If you configured using Group Defaults, assign Network Station users to the group you created in step 4. This is not necessary if you configured all the settings at the System Defaults level or at the NSMUser group, which is the default group, because the settings then apply to all users.</td>
<td>In NSM, select <strong>Select User’s Group</strong>, enter a user name or use Browse to select one from a list. Click on <strong>Next</strong>, and in the field labeled Group to use for defaults for this user, enter the group name you created in step 4 (or use the drop-down list and select the group from the list), and click on <strong>Finish</strong>. This is required so that eSuite users inherit the settings that were configured in the group you created in step 4.</td>
<td></td>
</tr>
</tbody>
</table>

**Using eSuite WorkPlace Administrator**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Start the eSuite Workplace Administrator.</td>
<td>There are three ways to start the eSuite WorkPlace Administrator but the easiest way is to access Network Station Manager and start the eSuite WorkPlace Administrator from within NSM using the Desktop Setup task. An alternate way is to log on to a Network Station as user admin and start the WorkPlace Administrator from the eSuite Desktop. On NT and AIX, you can also use the ewadmin command to start the WorkPlace Administrator directly on the server but this method is not recommended because it does not allow you to import users.</td>
</tr>
<tr>
<td>Check</td>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 15    |      | Add eSuite users to the eSuite Registry. | In eSuite 1.5, you cannot create users in the eSuite Registry directly using the WorkPlace Administrator. Users and groups are added either by importing them from the server’s database, or automatically when they are defined in NSM as being eSuite users (having an eSUite desktop).  
**Note:** If you migrated from a previous release, the eSuite Registry may already contain users and groups; in that case, these users and groups can still be used as is. |
| 16    |      | Customize the mail task.  
**Note:** The mail task cannot be used without first being customized, but the customization can be done either in advance by the administrator or by the user when he or she gets prompted for the required parameters. | In the WorkPlace Administrator panel, click the **Software** tab, then in the Configure Software section in the bottom left-hand corner of the panel, click on **Group Defaults**. In the Select a group column, click on the **All Users (Default)** group. (You can select more than one group.) Then in the Software to customize list, select **MailSessionManager** and click on **Customize**.  
Enter the required data, such as the name of the mail server(s) valid for your site, as provided by a network administrator and click on **Done**.  
See 4.3, “Customizing the Mail Task” on page 58 for details if required. |
| 17    |      | Customize the browser if a proxy is required.  
**Note:** If the Web browser is only used on the intranet, this step is not required. | On the WorkPlace Administrator panel, select the **Groups** tab and in the Select a group list, click on **All Users (Default)**, and on **Group Settings** at the bottom of the Groups list. In the next panel, you are by default positioned at the Proxy Configuration tab; use the drop-down list that appears just below the word Servers, and select the **Connect through proxy server** entry in order to open up the proxy fields. Enter the proxy information valid for your site, and click on **OK**.  
See 4.2, “Customizing the Browser Task” on page 55 for details if required. |
| 18    |      | Customize LDAP if you need access to an address book that resides on a remote server. | Apart from their own personal name and address book, users can access a company or corporate name and address book from the mail or calendar tasks. This additional name and address directory is configured through LDAP.  
In the WorkPlace Administrator panel, click the **Software** tab. Then in the Configure Software section in the bottom left-hand corner of the panel, click on **Group Defaults**. In the Select a group column, click on the **All Users (Default)** group. (You can select more than one group.) Then in the Software to customize list, select **LDAPSourceManager** and click on **Customize**.  
See 4.4, “Customizing LDAP” on page 67 for details. |
Chapter 2. Installing Lotus eSuite WorkPlace 1.5

This chapter provides a step-by-step illustrated example of the installation of eSuite WorkPlace 1.5 on a Windows NT server.

It also provides a summary of the steps required to install eSuite WorkPlace 1.5 on AS/400, RS/6000 and S/390 platforms; these instructions however have not been tested but only reproduced from the Readme files for those different platforms.

2.1 Prerequisites for All Platforms

Before you install eSuite WorkPlace 1.5 on any server, please review the following prerequisites in order to ensure a smooth installation:

2.1.1 Readme Files

In all cases, make sure that you consult the latest readme files available at http://boulder.service.ibm.com/nc to ensure that you have the latest information.

We have reproduced here, for your convenience, most of the information that is present in the readme files for the different platforms, but the information available on the Web will always be more current than this redbook.

2.1.2 Network Station Hardware

The minimum recommended IBM Network Station hardware for Lotus eSuite WorkPlace is a model 1000 with 64MB of RAM because this is what the product has been designed for.

2.1.3 Domain Name Server Configuration

eSuite needs to be able to resolve the IP host name of the server by using both the fully qualified IP host name, for example server.company.com, and also the short form (unqualified IP host name), for example server. A domain name server must therefore be accessible by the Network Station that is running eSuite.

If a DNS server is not available on your network, your Windows NT server can be configured as a DNS server and/or DDNS server.

2.1.4 Web Browser

To access the Network Station Manager, you first need a browser that is JavaScript-enabled.

In addition, if you are using the eSuite WorkPlace Administrator from within the Network Station Manager application, then the browser you use to access the Network Station Manager must have support for the JDK 1.1. You need either:

• Netscape Navigator 4.04 with JDK 1.1 support; this JDK 1.1 support can be applied using a fix that is available on the Lotus eSuite Workplace 1.5 CD, or from the downloaded Web site.

Or you can use Netscape 4.06 or above, which already includes this fix.

Note: In AIX, Netscape Navigator 4.06 (or higher) is required.
• Microsoft’s Internet Explorer 4.01 with the Remote Method Invocation (RMI) support that can be applied using a fix available at http://www.alphaworks.ibm.com/formula/RMI.

2.2 Installing eSuite 1.5 on a Windows NT Server

To install the eSuite WorkPlace on a Windows NT server, please follow the steps outlined below.

2.2.1 Windows NT Server Prerequisites

The prerequisites specific to a Windows NT server are:

• The JDK 1.1.6 must be installed. You can download this from http://support.lotus.com/css.nsf/Links/esuite/. The JDK 1.1.6 is the only version supported.

• A domain name server must be available on the network.

• The IBM Network Station Manager Release 3.03 must be installed and functioning on either a Windows NT Server 4.0 or Terminal Server Edition. The prerequisites for NSM 3.03 itself are:

  • One of the following Web servers:
    • Lotus Domino Go 4.6.2.2

    **Note**: Domino Go 4.6.1 is still acceptable but it is preferable to use the latest version. The Domino Go version on the NSM 3.03 CD is the 4.6.2 version. If you re-install it, and you happen to be on Windows NT 4.0 Terminal Server Edition, do not forget to issue the change user /install command before re-installing.

    • Microsoft’s Internet Information Server 4.0

Please refer to IBM Network Station Manager Installation and Use, SC41-0664 product publication and to IBM Network Station Manager Release 3 Guide for Windows NT, SG24-5221 redbook for instructions on how to install this product.

2.2.2 Pre-Installation Notes

The IBM Network Station Manager Release 3 Service Update 3 (3.03) installation process, or the upgrade from NSM 3.03 to 3.04 may install a Lotus eSuite WorkPlace 1.0 patch regardless of whether or not you have Lotus eSuite WorkPlace 1.0 installed.

1. If you have Lotus eSuite WorkPlace 1.0 installed, this problem does not affect your Lotus eSuite WorkPlace 1.5 installation.

2. If you do not have Lotus eSuite WorkPlace 1.0 installed, this patch prevents a successful Lotus eSuite WorkPlace 1.5 installation and must be removed before you install WorkPlace 1.5.

Take the following corrective action before you install Lotus eSuite WorkPlace 1.5:

• Delete the eSuite folder in the x:\{float}\nstation\Prodbase subdirectory where x:\{float\} is the location where Network Station Manager Release 3.03 is installed.
2.2.3 Installation Instructions

Insert the Lotus eSuite WorkPlace CD in the CD-ROM drive on the server and the InstallShield should launch automatically.

If the autorun fails, select Start => Run and type
x:\ntnsm\en\products\eSuite\setup.exe where x: is the CD-ROM drive.

![Installation Initial Panel](image)

Figure 1. Installation Initial Panel

Click on the View Install Information to display the contents of the readme file; we recommend you should always review this file before proceeding with the installation as the latest modifications to the installation instructions are always in the readme file. This readme file is actually called install.txt and is located in x:\ntnsm\en\products on the CD.

Then click on Install Lotus eSuite WorkPlace to start the install process.

The installation process itself is fairly uncomplicated. The usual InstallShield panels are displayed, one of which is the destination directory prompt, as shown in the next figure:
If you attempt to install and you do not have the JDK 1.1.6 installed, the installation process issues a warning and terminates.

If a previous version of eSuite is installed, the following message is issued.

A click on OK proceeds with the uninstallation of the previous version before continuing with the installation of the current version, while preserving the entries that were present in the eSuite Registry.

After the installation process ends, reboot the server to complete the installation.

2.2.4 Automated (Batch) Installation

If necessary, you can now use a flag on the setup.exe command to install Lotus eSuite WorkPlace in silent mode on more than one identical server.

During your first server installation, the setup.exe records installation responses in a response file called setup.iss, which is then used to install Lotus eSuite WorkPlace on additional identical servers.
Installing Lotus eSuite WorkPlace 1.5

Note: The automatic installation only works from a CD copy of the Lotus eSuite WorkPlace software. You cannot use this procedure if you downloaded the Lotus eSuite WorkPlace software from the Web.

The procedure is as follows:

1. Generate the response file:

   On a command line, enter the following command (where x is your CD-ROM drive letter) to install Lotus eSuite WorkPlace on your first server and generate the setup.iss response file for additional installations:

   \[x:\ntnsm\en\products\esuite\setup.exe -r -SMS\]

2. Install the additional servers:

   To install Lotus eSuite WorkPlace automatically in batch mode on an additional identical Windows NT server, use the response file from your first installation. Use the setup command to invoke the response file.

   1. Copy the setup.iss file from your first installed server Windows NT subdirectory (commonly C:\WINNT) to the Windows NT subdirectory on your additional server.

   2. Enter the following command to run the Lotus eSuite WorkPlace software installation on your additional servers (where x: is the CD-ROM drive or a mapped network drive, and C:\WINNT is your Windows NT subdirectory):

      \[x:\ntnsm\en\products\esuite\setup.exe -s -rC:\WINNT\setup.iss\]

   3. To ensure the Lotus eSuite WorkPlace has been installed correctly, open the file C:\WINNT\setup.log and verify the last line of the file reads as follows: ResultCode=0.

2.2.5 Migration from Previous eSuite Release

If the eSuite WorkPlace installation process on Windows NT detects eSuite registry information from a previous eSuite installation, it preserves the existing registry files.

To complete the migration process (which updates the user’s registry files from a previous version of eSuite WorkPlace to the current release), start the Lotus eSuite WorkPlace Administrator on the server with the menu item on the Start menu or from within IBM Network Station Manager.

2.2.6 Auto-Configuration

The following items are automatically configured by the installation process:

1. NT Services

   When examining the NT services (click Start => Settings => Control Panel => Services), you should see two new entries labeled Java RMI Registry and Lotus eSuite WorkPlace Registry with a status of Started, as illustrated in the next figure:
Both of these services are configured to start automatically, and you should in fact see, after a reboot, two command prompt entries on the task bar:

One labeled \x:\jdk1.1.6\bin\rmiregistry.exe

One labeled \x:\jdk1.1.6\bin\java.exe

These remain on the task bar all the time and represent the services that have been started. To eliminate these entries from appearing on the Windows NT task bar, select the service, click on the **Startup...** button and click off the box labeled *Allow service to interact with the desktop*. These services will still start but will not show up as tasks on the task bar.

2. System Variables

The following three variables are also added to your system variables:

- `DESKTOP_HOME`, which contains, for example, \\nstation\prodbase\esuite.
- `JAVA_HOME`, which contains, for example, \d:\jdk1.1.6.
- `HOSTNAME`, which contains the server’s IP host name.

3. The Web server configuration file is updated to include the following directives:

- For the Lotus Domino Go Webserver on Windows NT, the additions are shown in the following figure.

```
Pass /esuite/com/lotus/jars/* d:\nstation\prodbase\esuite\com\lotus\jars/*
Pass /esuite/com/lotus/server/admin/images/*
d:\nstation\prodbase\esuite\com\lotus\server\admin\images/*
Pass /esuite/lotus_help/* d:\nstation\prodbase\esuite\lotus_help/*
```

*Figure 5. Directives Added to Domino Go Webserver Configuration File*
• For the Microsoft IIS Web server, the equivalent virtual directories are created, as illustrated in the figure below.

![Figure 6. eSuite Virtual Directories Added to IIS](image)

Note that if both Web servers are installed, the eSuite installation process updates both configuration files.

### 2.2.7 Creating a User Called admin on the Server

Later in the process, we will need to use a user called admin in order to initially access a configuration application called the eSuite WorkPlace Administrator.

Therefore, now is a good time to create this user ID on the server and make it a member of the NSMAdmin and NSMUser groups so that this user can also log on to the Network Station Manager.

### 2.2.8 Creating a New Group on the Server (Optional)

If all the Network Station users that are served by this server are also all eSuite users, then creating a new group on the server to identify the eSuite users is not necessary.

That is, if all users are eSuite users, all the eSuite-related settings can be defined at the System defaults level in Network Station Manager and these settings then
apply to all users. Another option is to use the existing NSMUser group to define the eSuite settings.

However, since it is likely that not all Network Station users are eSuite users, and the non-eSuite users do not require the eSuite WorkPlace desktop to come up automatically after logging on, it is preferable to define a group on the server that represents only the eSuite users, which is the method we use in the example given here. We create, in this example, a group called esuite that we use to configure the settings applicable only to the Network Station users that are eSuite users. The only drawback to using a specific group is that we will need an additional configuration step in NSM, for each user, in order to assign that user to this group.

Before we can enter this group name in any of the IBM Network Station Manager configuration panels, we need to first create this group on the server. If this is not done first, NSM issues an error message when a group name that does not yet exist on the server is entered in an NSM panel.

Here is an example of how this is done on a Windows NT server, using the User Manager for Domains application. (Other platforms have different but similar procedures for creating a group.)

Click Start => Programs => Administrative Tools => User Manager for Domains, and select Users => New Local Group in order to bring up the panel shown below:

![Creating a New Group in Windows NT](image)

Enter a group name, such as esuite, and then click the Add button to bring up a list of the existing user names. Select user names from the list in order to add them to this group.

In this example, let's assume that we have two users, Ariane and Thomas, that are already defined as Network Station users. That means that they are already members of the NSMUser group to allow them to log in from an IBM Network Station. We also make these two users members of the esuite group, as shown in the panel below:
2.3 Installing eSuite 1.5 on an AS/400 Server

The steps to install the eSuite WorkPlace on an AS/400 server are described in the following sections.

The readme file for the AS/400 platform is available at http://service.boulder.ibm.com/nc/lotus/workplace/as400/install.txt.

2.3.1 AS/400 Server Prerequisites

The following products need to be installed on the server before installing the eSuite code:

- OS/400 V4R2 or V4R3 and latest CUM Tape
- 5769JV1 - AS/400 Developer Kit for Java
- 5648C05 - IBM Network Station Manager Release 3.1 (Release 3.0 + Group PTF SF99082 ordered after 11/16/98)
- 5769SS1 - PTF SF49066 for Security enhancements (V4R2 only)
- 5769JV1 - PTF SF49635 and PTF SF49750 for JDK 1.1.6 (V4R2 only)
- 5769999 - PTF MF19586 for JDK 1.1.6 (V4R2 only)

If a previous version of eSuite WorkPlace is installed and you wish to preserve the configuration/registry information for the users, one of the following browsers is required. This is because you can only start the WorkPlace Administrator from within Network Station Manager in order to complete the migration process.

- Netscape Navigator 4.04 with the JDK 1.1 support, which can be applied using a fix that is available from the download Web site at http://service.boulder.ibm.com.
- Microsoft’s Internet Explorer 4.01 with Remote Method Invocation (RMI) support that can be applied using a fix available at http://www.alphaworks.ibm.com/formula/RMI.

Figure 8. Adding Members to the esuite Group
2.3.2 Installation Instructions

To install the Lotus eSuite WorkPlace code:

1. If you have a previous version of eSuite WorkPlace installed, have all eSuite users log off and end the registry server using the QESUITE/ENDESRSVR command.

   If the RMI server was started by the STRESRSVR command, it will be running in the QESRRMI job in subsystem QSYSWRK. You need to end QESRRMI using the WRKACTJOB command and option 4. Before installing, ensure that both the QESRSVR and QESRRMI jobs have ended.

2. Insert the eSuite CD-ROM into the CD-ROM drive.

3. Enter `RSTLICPGM LICPGM(5648KN3) DEV(<device name>) OPTION(*BASE), where`<device name> is the name of CD-ROM device (for example OPT01) or is *SAVF when installing from saved files. If restoring from save files, include the SAVF(<library>/<savefile name>) parameter, filling in <library> and <savefile name> appropriately.

4. Enter `RSTLICPGM LICPGM(5648KN3) DEV(<device name>) OPTION(1)`.

5. Enter `RSTLICPGM LICPGM(5648KN3) DEV(<device name>) OPTION(2)`.

2.3.3 Migration

If a previous version of eSuite WorkPlace had been installed, the registry files were preserved. To finish the migration process (updating the user's registry files from a previous version of eSuite WorkPlace to the current release), start the Lotus eSuite WorkPlace Administrator using Netscape Navigator or Microsoft Internet Explorer (see "Starting the eSuite WorkPlace Administrator").

2.3.4 Auto-Configuration

Successful installation of the eSuite code should have made the following configuration changes to the AS/400 system:

1. The STRESRSVR and ENDESRSVR commands are added to the QESUITE library.

2. The QESUITE user profile is created.

3. The Lotus eSuite product files are copied to the AS/400 Integrated File System under /QIBM/ProdData/eSuite directory and registry files are copied to the /QIBM/UserData/eSuite directory.

2.3.5 Manual Configuration on the AS/400

On an AS/400, a few additional steps are required before the eSuite WorkPlace can be used:

1. Create an admin user profile using CRTUSRPRF USRPRF(admin) PASSWORD() USRCLS(*SECOFR) TEXT(‘eSuite administrator’) filling in an appropriate password.

   This user called admin is required to log on to the eSuite WorkPlace Administrator.

2. Have the system operator or a user with *ALLOBJ special authority start the eSuite registry server using the QESUITE/STRESRSVR command.
3. Ensure the system value QUTCOFFSET is set correctly for your site. See the OS/400 Work Management (SC41-5306) publication for more information.

4. Add the following HTTP directive using the WRKHTTPCFG command:
   
   Pass /esuite/* /QIBM/ProdData/eSuite/*

   Use the STRTCPVR SERVER(*HTTP) RESTART(*HTTP) command to restart the HTTP server, so the changes take affect.

5. Start the RMI registry and eSuite registry server.

   The RMI and eSuite registry servers execute on the AS/400 and need to be started prior to starting the eSuite WorkPlace.

   Note that the eSuite registry server should be stopped prior to ending TCP/IP or powering down the system. If the RMI server was started by the STRESRVR command, it will be running in the QESRRMI job in subsystem QSYSWRK. You need to end QESRRMI using the WRKACTJOB command and option 4. Before ending TCP/IP or powering down the system, ensure that both the QESRSVR and QESRRMI jobs have ended.

   - To start the RMI and eSuite registry servers, issue the QESUITE/STRESRVR command. A message indicating the eSuite registry server has started will be issued to the QSYSOPR message queue.
   - To stop the eSuite registry server, issue the QESUITE/ENDESRSVR command.

2.4 Installing eSuite 1.5 on an AIX Server

   To install the eSuite code on an AIX server, follow the instructions provided in the following sections.

2.4.1 AIX Server Prerequisites

   On an AIX server, the following software must be installed and configured before installing the Lotus eSuite WorkPlace:

   - AIX 4.2.1 or above.
   - Domain name server available on the network.
   - Java Development Kit (JDK) 1.1.4.4 or above for AIX. (This must be installed as an LPP.)

   To install JDK 1.1.4.4:

   1. Install JDK 1.1.4 for AIX.
   1. Install APAR IX81968. The location of this APAR is http://198.17.57.66/rs6k/fixdb.html.
   - IBM Network Station Manager for AIX VRMF 1.3.0.2 located at http://service.boulder.ibm.com/nc/rs6000/preindx.html.
   - Netscape Navigator 4.06 Web Browser.

   Note: You must use Netscape Navigator 4.06 if you use a browser to launch the Lotus eSuite Workplace Administrator from Network Station Manager.
2.4.2 Installation Instructions

To install eSuite on an AIX server, follow these steps:

1. If you have a previous version of eSuite WorkPlace installed, have all eSuite users log off and end the registry server processes by issuing `ps -ef | grep java` to find the process IDs and then issuing `kill -9 xxxx`, where `xxxx` is the process ID for each registry server.

2. Insert the eSuite CD-ROM into the CD-ROM drive.

3. Issue the `smitty install_latest` command from the AIX command line and use `/dev/cd0` as the device from which you are installing.

4. When prompted to specify the code you wish to install, press F4 to get a list of filesets to choose from, select `netstation.eSuite.rte`, and press Enter to proceed with the install.

2.4.3 Migration

If you installed a previous version of eSuite WorkPlace, the eSuite Workplace 1.5 installation preserved the existing registry files. To finish the migration process (which updates the user's registry files from a previous version of eSuite WorkPlace to the current release), log in as admin and start the Lotus eSuite WorkPlace Administrator on the AIX server by issuing the command `/etc/ewadmin`.

After this command is executed, a message similar to the one below is displayed indicating that migration has completed:

```
Information:  A KeyRing String of length 4517 was read in from the WPKeyRing class.
Information:  The KeyRing String was successfully written to the key 'system.desktop.security' under the attribute 'rootCAKeyRing' in the 'All Users (Default)' group registry file.
```

2.4.4 Auto-Configuration

A successful installation of the eSuite code should result in the following configuration changes having been made to the AIX system:

- The Java RMI registry and Lotus eSuite Workplace Registry have been automatically started. These registries also have been added as services to start at system boot time.
- The Pass `/eSuite/* /usr/netstation/eSuite/*` Web server directive has been added to the `/etc/httpd.conf` file.

2.5 Installing eSuite 1.5 on an OS/390 Server

To install the eSuite code on an OS/390 server, follow the instructions provided in the following sections.
2.5.1 S/390 Server Prerequisites

The following products and components need to be installed before you install the eSuite code:

- OS/390 Version 2 Release 4 or later
  This is not supported on earlier versions of OS/390. The user who installs the code needs WRITE privileges to be able to create files and subdirectories under /usr/lpp/eSuite and /etc/eSuite. Also, a configuration file under /etc/nstation must be updated.

- 5648-C05 - Network Station Manager Release 3.1 (3.0 + PQ20636 and PQ20637)

- Java for OS/390 JDK 1.1.4 with OW35594 applied

2.5.2 Migration

If a previous version of eSuite WorkPlace is installed and you wish to preserve the configuration/registry information for the users, one of the following browsers is required. This is because you can only start the WorkPlace Administrator from within Network Station Manager in order to complete the migration process.

- Netscape Navigator 4.04 with the JDK 1.1 support that can be applied using a fix that is available on the Lotus eSuite Workplace 1.5 CD, or from the downloaded Web site

- Microsoft’s Internet Explorer 4.01 with the Remote Method Invocation (RMI) support, which can be applied using a fix available at http://www.alphaworks.ibm.com/formula/RMI.

The following amounts of space are required:

- 26MB of HFS data set space on the OS/390 system under /tmp for the pax file.

- 45MB of HFS data set space on the OS/390 system under /usr/lpp/eSuite for the exploded directory structure.

- 250KB of HFS data set space on the OS/390 system under /etc/eSuite for the eSuite directory structure. In addition, approximately 1.5KB of additional space is required per user and group.

  This additional space will vary, depending upon the tailoring that is performed in the eSuite WorkPlace Administrator for the users, groups and system preferences.

2.5.3 Installation Instructions

To install eSuite on an OS/390 server, follow these steps:

- Define the ADMIN user ID as a super user. It may be redefined it later in the installation process.

- If a previous version of eSuite is already installed, have all eSuite users log off, end the registry server and RMI server before installing the new version, then remove the eSuite code directory structure.

- Upload the eSuite PAX file and create the new directory structure.

- Create the eSuite registry directory structure under /etc (if this is a fresh installation).
• Update HTTP directives in httpd.conf to pass control to eSuite code when necessary.

• Create a null file, eSuite.ins, in /etc/nstation/SysDef to act as a flag to the NSM code that eSuite 1.5 is present.

• Configure the NFS server to export the eSuite code directories.

• Update defaults.dft in /etc/nstation/StationConfig to contain the mount command for /usr/lpp/esuite.

2.5.4 Starting the RMI Registry and eSuite Registry Server

It is recommended that the RMI registry and eSuite registry be set up to automatically start when OS/390 is IPLed. Consult the OS/390 manuals and your local operational guidelines for this procedure.

You can verify the registries are running by issuing the OMVS ps and grep commands.

```
ps -ef | grep NCS
ps -ef | grep rmi
```

These commands should return with PIDs for each process.

To manually start the registries, execute the /usr/lpp/esuite/esuite.sh script. This shell script uses three environment variables as overrides for the location of the Java, eSuite code, and eSuite registry directories.

• $JAVA_HOME is the location of Java. It currently defaults to /usr/lpp/java/J1.1.

• $eSuiteRootPath is the location of the eSuite code that you installed at /usr/lpp/esuite. It currently defaults to this path. You should not change this value.

• $eSuiteRegistryPath is the location of the eSuite registry data. This is the directory structure that you created at /etc/eSuite/registry.
Chapter 3. Configuring eSuite 1.5

After the installation process is complete, there are a few configuration tasks that need to be performed using the Network Station Manager and the eSuite WorkPlace Administrator before an IBM Network Station user can actually use the Lotus eSuite WorkPlace desktop.

3.1 Configuring eSuite 1.5 Using Network Station Manager

Because eSuite is a set of applications written in Java that execute on the IBM Network Station, there are some Network Station-related configuration parameters that must be set before these applications can be made accessible to the Network Station users.

3.1.1 What Is Network Station Manager?

Network Station Manager is an application that manages the configuration parameters such as hardware settings for the actual Network Station as well as parameters that are specific to users and groups, which determine the way that the Network Station desktop looks; for example, what colors are used, and what functions are made available on the menu bar, etc.

Network Station Manager therefore is a user-friendly graphical interface used to enter settings and values for parameters recorded in configuration files that are downloaded to the Network Station at boot time, thereby determining how this Network Station operates.

Let us take a look at the parameters that are specific to the eSuite WorkPlace.

3.1.2 Configuration Tasks

There are four settings that need to be configured using NSM:
1. A domain name server setting
2. The eSuite desktop
3. A time zone environment variable
4. The eSuite colors

The DNS is usually configured at the System defaults level since it really applies to all users and groups, and in fact, is usually required even if you do not use eSuite, so it is likely that this is already configured in NSM.

However, the three other settings are specific to eSuite and are required. The question is however, should these be configured at the System defaults level, the group level, or the individual user defaults level?

We can eliminate the user defaults level immediately since you do not want to have to configure these settings for every individual eSuite user; that leaves you with the choice of using either the System defaults or the Group defaults level, and if using the group level, which group to use.

If all your Network Station users are also eSuite users, meaning that you want the eSuite WorkPlace desktop to appear on their Network Stations when they log on,
then the decision is easy and you can configure these settings at the System
defaults level.

However, if you want the eSuite desktop to appear only on a certain number of
the Network Stations, it is probably best then to configure these settings at a
group level, and to make only the eSuite users members of that group. This
avoids having the eSuite desktop come up automatically on the Network Stations
where users are not eSuite users. This is done by using, in NSM, the Select
User’s Group task and indicating to NSM the group from which each user should
inherit settings.

**3.1.3 Users and Groups - How Does It Work?**

As users and groups are used at the server level, the NSM level and the eSuite
Registry level, this can be a bit confusing sometimes. Therefore, we have tried to
illustrate the process and explain the different levels of groups using the diagram
in Figure 9 on page 24.

First, let’s review a few facts:

1. Overall, there is essentially only one set of users and groups. In other words,
   the same users and groups are used on the server, in NSM and in eSuite.

   With the previous version, you could create users and groups in the eSuite
   Registry (using the WorkPlace Administrator) that were different from the
   server’s users and groups. You could add individual users, and assign users
to groups, and work with users and groups independently of what existed in
   the server definitions. This is no longer the case with Release 1.5; users and
groups are only managed on the server and they are imported from the server
using an import function.

   Only if you have migrated from a previous version can you have users and
groups in eSuite that are not in the server as well, and in that case, the import
function warns you about this and gives you the option to delete these users
and groups from the eSuite Registry.

   The group in eSuite called All Users is an exception as it is there to represent
   the default group for all users.

2. On the server, a user can inherit settings from more than one group.

   On the server, a user can be a member of, or belong to, more than one group;
   therefore, he or she inherits the combination of all the settings from all the
   groups.

   In this case, the group is mainly used to allocate user rights to a user.

   For example, a user that belongs to the NSMUser group has the right to log on
to a Network Station and to use the Network Station Manager to set his or her
own user preferences.

   If he belongs to the NSMAadmin group, he also has the right to use the NSM to
set all parameters. Therefore, if the user belongs to both groups, he or she
inherits the user rights from both the NSMUser and the NSMAadmin groups.

3. In NSM, settings (configuration parameters) determine the appearance of the
   user’s Network Station desktop; for example, the background color of the
   screen, or whether the mouse is right or left-handed, the size of the font used
   for menus, the location of some of the icons, etc.
These settings for the user can be specified at three levels:

- System defaults
- Group defaults
- User defaults

Settings at the System defaults level override the default "shipped" settings. Similarly, settings specified at the Group level override similar settings specified at the System defaults level, and those at the user level override all previous levels.

A specific user, therefore, inherits the result of the settings from all three levels, some of which may have been overridden along the way.

However, even though the user at the Windows NT level may belong to more than one group, he or she can inherit settings from only one group in NSM.

If a user is not specifically assigned to a group in NSM, the default is that he or she belongs to the primary server group. In Windows NT, in effect, the default group is the NSMUser group.

On the other hand, if the user is specifically assigned to a group in NSM using the Select User's Group setup task, he or she inherits the NSM settings for that group and that group only.

4. In eSuite, settings determine which categories of applications appear on the user’s eSuite desktop and which tasks (applications) the user is allowed to use.

In eSuite, groups are used to specify which task can be used. For example, the All Users group allows access to practically all the applications except the administrative tasks such as the WorkPlace Administrator. On the other hand, the Administrators group does give access to the Administrative tasks.

A user can belong to more than one group. He or she inherits the settings from all the groups he or she belongs to. A user that is a member of the Administrators group for example, is allowed the administrative tasks as well as all the applications since he or she is also a member of the All Users group (by default).

Now, let’s examine the diagram in the next figure to see how a user ends up with a particular combination of settings based on his or her user name and the groups that he or she belongs to.
Here is a brief description of what the diagram above tries to convey. The diagram is divided into three areas representing the settings that can be configured into each of these areas: Windows NT, NSM and eSuite Registry. The thick line that snakes through the diagram symbolizes the settings that this user inherits through the different environments.

1. Starting at the top of the diagram, in the area that represents Windows NT settings, User1 is a member of two groups, NSMUser and eSuite, as configured via the User Manager for Domain application, and therefore inherits the user rights from these two groups.

2. In the area that represents NSM settings, User1 inherits the settings from the combination of System Defaults and User defaults but also from the group defaults of the eSuite group, which in this case contains the eSuite-specific settings such as the eSuite desktop, colors and time zone.

Settings from the NSMUser group are not used when User1 is assigned to the eSuite group in NSM. This assignment is done through the use of the Select User’s Group Setup task in NSM, as illustrated in the next figure:
3. Finally, in eSuite, User1 inherits the ability to use all the tasks that are associated with the All Users, NSMUser and eSuite groups.

3.1.4 Starting the Network Station Manager

The IBM Network Station Manager is accessed using a browser, either on the server itself or from any location that has access to this server.

The URL is: http://server/networkstation/admin.

On a Windows NT server, there is usually an icon on the desktop that can be used to start the Network Station Manager.

**Note:** You must also use a JavaScript-enabled browser and one that supports the JDK 1.1 in order to be able to use the eSuite WorkPlace Administrator from within NSM.

3.1.5 Configuring the Domain Name Server Data

Use the IBM Network Station Manager to ensure that your domain name server (DNS) information is properly configured.

This is required so that the Network Station has proper access back to its server but also for applications such as the browser to be able to properly resolve addresses both on the intranet and the Internet.

To configure the DNS information in NSM, use the following procedure:

1. Start the Network Station Manager and log on as an administrator.

2. On the main Network Station Manager panel, in the Setup tasks on the left, select **Hardware**=>**Workstations**=>**System Defaults**, then scroll down to Domain Name Server and select an entry as illustrated below:
Domain Name Server:

Domain name server to use:

- DNS Configuration from BOOTP or DHCP server
- DNS Configuration created by Network Station Manager

[Update Network Station Manager DNS file]

Figure 11. DNS Configuration in IBM Network Station Manager

With this configuration item, you are actually selecting the source from which the Network Station gets its domain name server configuration information, which consists of:

- The IP address of a domain name server (or servers)
- The default IP domain name

The source of this information can be either:

- A DHCP server
- A configuration file called hosts.nsm created by the Network Station Manager on the server and downloaded to the station during the boot process.

This is illustrated in Figure 12.

Figure 12. Choosing a Source for the DNS Configuration Data
3. If your IBM Network Station is booting using a DHCP server, in Figure 11 on page 26, select the first entry labeled **DNS Configuration from BOOTP or DHCP server**. Normally, the network administrator would have configured the DNS configuration data in the DHCP server as data to be transmitted to the station when it boots.

**Note:** It is possible to boot a station using DHCP and transmit the proper IP address that the station should use, and the address of the server that it should contact, but to omit the DNS configuration data. This would be unusual, but in that case, the second entry should be selected even though you are booting using DHCP.

4. If you are not using DHCP to boot the Network Station, in Figure 11 on page 26, select the second entry labeled **DNS Configuration created by Network Station Manager**. In this case, the Network Station Manager copies the DNS configuration from the server configuration file into a file called hosts.nsm, which is downloaded by the Network Station during the boot process.

This step ensures that the IBM Network Station, once it is operational, knows which domain name server (DNS) to access in order to resolve IP host names into IP addresses.

If the Network Station is located on a network inside a corporation (intranet) and the browser is used to access URLs that are outside the company’s network through a firewall, then an additional step required is the configuration of a proxy server for the browser application. See 4.2, “Customizing the Browser Task” on page 55 for an example.

For additional details on this topic, please see 6.1, “Troubleshooting Domain Name Server Configuration” on page 119.

### 3.1.6 Configuring the Desktop in IBM Network Station Manager

Configuring the desktop lets you specify which IBM Network Station users have the Lotus eSuite WorkPlace desktop configured as their default desktop when they log on to their IBM Network Station.

Use the IBM Network Station Manager application to define the default desktop settings for members of the group we defined earlier as the esuite group.

In NSM, select **Startup**⇒**Menus**⇒**Group Defaults**. Enter the name *esuite* as the group name (or use Browse to select the group name from a list), as illustrated below, and click **Next** to continue.
Installing and Customizing Lotus eSuite WorkPlace 1.5 for IBM Network Stations

In the Desktop and Menu Bar Options, the choices are as illustrated below:

![Desktop and Menu Bar Options](image)

Select the **Lotus eSuite WorkPlace with menu bar** option. This means that any user that is a member of the esuite group gets by default, at logon, the eSuite desktop automatically started on his or her Network Station and an eSuite button added to his or her menu bar.

**Note:** This works differently than the normal way of autostarting an application on a Network Station and of creating an item on the menu bar. If this was done in the normal fashion, one of the startup.nsm files would contain the statements that start the eSuite desktop and the statements that create the menu bar item. Do not look for them because all of this is actually done internally by the Network Station Login client.

The login client (actlogin) examines the NSM configuration files to see if the user has the eSuite desktop configured, with or without the menu bar, and if it does, it
triggers the use of the esuite.nsl configuration file that contains the statement to start eSuite, and actlogin also creates the eSuite menu bar item, if it was requested in NSM.

There is no automatic way to configure an eSuite button on the menu bar to start eSuite on demand without having it autostarted at logon time unless you manually configure the eSuite desktop as a Java application to be started.

3.1.7 Defining a Time Zone Environment Variable

We also need to define an environment variable for the time zone; to do so, in the NSM Setup Tasks on the left, select Startup => Environment Variables => Group Defaults. Enter esuite as the group name, and click on Next.

![Figure 15. Setting an Environment Variable](image)

On the next panel, enter the variable name TZ (for time zone) and enter the value appropriate to your location.

In our example here, we used the Eastern Standard Time (EST) zone.

![Figure 16. Setting the TZ Environment Variable](image)

3.1.7.1 Defining the TZ Variable at the System Defaults Level

The TZ environment variable can be defined at the System defaults level instead of specifically at the Group Level for eSuite users because the variable is in fact applicable to any Java application or applet running on the Network Station.

For example, the Java Clock Demo applet also seems to be making use of this variable.
3.1.7.2 Time Server - GMT or Local Time

In addition, it is possible that the TZ variable may not even be required if the time server is configured to send local time, instead of GMT time, to the Network Station at boot time.

![Diagram of Time Server Configuration]

Figure 17. Getting the Time from the Time Server

Remember that the time server can be configured to send local time instead of GMT. The Network Station then adjusts according to its configuration settings, as illustrated in the diagram above.

To access the TIMED Configuration, select Start => Programs => eNetwork On-Demand Server => Time Server Configuration.

The next figure illustrates the Time Server configuration panel on a Windows NT server. By default, the time server sends GMT, in which case the TZ environment variable is required to adjust to the local time.

However, if the Adjust to local time entry is checked on the time server configuration, it is the local time of the server that is sent to the Network Station at boot time, and therefore the TZ variable should not be used.

If TZ is used when local time is sent by the server, the Network Station is unaware of this and it makes an additional adjustment as if it were using GMT, resulting in a double time zone adjustment.
If all workstations are in the same time zone as the server, local time can be used but in all other cases, it is probably preferable to configure the time server to send GMT and to make the adjustment in the Network Station configuration.

3.1.8 Enabling eSuite Colors

We also need to set the eSuite colors; to do so, in the NSM Setup Tasks on the left, select **Hardware => Workstations => Group Defaults**. Enter *esuite* as the group name, click on **Next** and scroll down to the Monitor Settings section.

At the bottom of the section, use the drop-down list Enable eSuite colors (web palette) and select the **Yes** entry.
3.1.9 Selecting a User's Group for eSuite Users

Even though we previously made our two sample users, Thomas and Ariane, members of the esuite group on the server, we still have to indicate to Network Station Manager the name of the group from which these users should inherit settings.

In other words, these two users inherit the settings that are made at the system level and at the individual user levels in NSM, but we can also indicate a group from which they can inherit settings. Since we have configured all eSuite-related settings in a group called esuite, we need to tell NSM to associate these two users with the esuite group.

Even though a user can belong to more than one group at the server level, that user can only inherit settings from one group in NSM.
To do this, select the **Select User’s Group** task in the NSM Setup Tasks list, and use the **Browse** button to display all the user names that are defined in the Windows NT User Manager for Domain definitions.

![Figure 20. Selecting a Users Group](image)

In the Select a user list, we choose Ariane for example, and choose **Select** and **Return**, and then **Next**, which brings up the next panel.

![Figure 21. Choosing a Group for a User](image)

In the panel above, we choose the **esuite** group from which our user Ariane will inherit settings.

We repeat the procedure for user Thomas.
3.1.9.1 Limitation
There does not seem to be a way, in one operation, to select multiple users and assign them all to a group in NSM as we would probably like to do in this example if we had 150 eSuite users.

It is therefore easier to configure the eSuite settings at the System Defaults level, in which case we do not need to assign users to an NSM group.

However, as previously mentioned, if you have a mixed environment of eSuite and non-eSuite users, and you do not want the non-eSuite users to be burdened with having to wait for the eSuite desktop to come up on their Network Station at logon time and then have to close it, then you may not have a choice and simply have to make a group assignment in NSM.

3.2 Configuring eSuite 1.5 Using eSuite WorkPlace Administrator
The last set of configuration tasks to be accomplished, none of which are actually mandatory in order for a user to start using the eSuite WorkPlace, is performed using the eSuite WorkPlace Administrator. In summary, these are:

- Managing users and groups in the eSuite Registry
  The Release 1.5 WorkPlace Administrator now offers an import function which facilitates the synchronization of users and groups defined in the NSM configuration files with users and groups defined in the eSuite Registry.
  Release 1.5 also provides a facility that automatically adds users to the eSuite Registry when they log on to use the eSuite Workplace or when an administrator uses NSM to add the user to a group that has the eSuite desktop specified.

- Customizing applications
  Once the user has access to the eSuite WorkPlace, he or she can immediately use most of the applications without any further configuration. However, there are some applications, such as the mail task for example, that must be customized before they can be used. This is covered in Chapter 4, “Customizing eSuite Applications” on page 51.

- Customizing the eSuite desktop
  The WorkPlace Administrator is also used to customize the user’s desktop by adding or removing categories and tasks that the user has access to.

3.2.1 What Is eSuite WorkPlace Administrator?
The eSuite WorkPlace Administrator updates the eSuite Registry, which is the configuration file containing eSuite user, eSuite group and eSuite application configuration data for the eSuite WorkPlace desktops.

The Network Station Manager on the other hand operates on configuration data related to Network Station users and applications, irrespective of whether these Network Station users are eSuite users or not. Network Station Manager also controls all the hardware configuration data pertinent to the Network Stations whereas the eSuite WorkPlace Administrator is only concerned with the eSuite applications configuration data.
The diagram below attempts to summarize some of the major components and positions the WorkPlace Administrator relative to the Network Station Manager.

3.2.2 Accessing/Starting the eSuite WorkPlace Administrator

The eSuite WorkPlace Administrator comes pre-configured with two user names that have the required authority to log on and use the WorkPlace Administrator as administrators.

These user names are admin and root. They must first be defined as users on the server before they can be used to log on for the first time to the WorkPlace Administrator. This is why we defined this user earlier on in this example.

Note: The user called root is for use by AIX users and does not have to be defined since an AIX system always has a user called root, which is sort of an equivalent to the default user called administrator in Windows NT.

There are three ways to access and start the eSuite WorkPlace Administrator. In all cases, you must access the first time as user admin (or root for AIX):

1. Directly on the server by using the ewadmin.bat command file from a command line or by using Start => Programs => Lotus eSuite WorkPlace => Lotus eSuite WorkPlace Administrator as illustrated below:
Figure 23. Starting the WorkPlace Administrator on the Server

The Properties for the above shortcut are shown below, indicating that this shortcut calls the ewadmin.bat batch file.

Figure 24. Properties for the WorkPlace Administrator Shortcut

Notes:

1. On Windows NT, the ewadmin command is located in \nstation\prodbase\esuite. On AIX, it is the /etc/ewadmin script.

2. On AS/400 and OS/390, the eSuite WorkPlace Administrator is not accessed directly from the server but rather from an eSuite task on the Network Station's eSuite WorkPlace desktop or from within Network Station Manager.

3. As an alternative to using the shortcut when logged on as user admin, you can also use (on Windows NT and AIX) the command: ewadmin -user admin.

2. From the eSuite WorkPlace desktop on the Network Station by using the WorkPlace Administrator task in the Administration category.
If you choose to access the WorkPlace Administrator from a Network Station, remember that the user called admin must have been made part of the NSMuser group in order to be able to log in to a Network Station.

3. From inside the Network Station Manager by choosing Desktop => Lotus eSuite WorkPlace tasks, as shown in the next figure:
Before you click on Next, you can choose System Defaults, Group Defaults, User Defaults or General Configuration. In all cases you are presented with the panel in Figure 27 on page 39.

The only difference that choosing one of the options makes is that you are pre-positioned at the right place in the next panel. For example, if you choose User Defaults and you enter the user name as Administrator, the next panel displays with the Users tab pre-selected and the Administrator user pre-selected.
For those who may be familiar with the WorkPlace Administrator panel of the previous release, we have, in the next figure, superimposed the eSuite 1.0 WorkPlace Administrator panel over the eSuite Release 1.5 version of the same panel to put the differences in evidence.

Notice that the functions are essentially the same and that only the layout has changed. The main visual change is that icons on the left of the Release 1.0 panel have become tabs at the top of the Release 1.5 panel.

Figure 27. Lotus eSuite WorkPlace 1.5 Administrator Main Configuration Panel
3.2.3 Giving WorkPlace Administrator Access to Other Users

Notice in the panel in Figure 27 on page 39 the check mark labeled Selected user has System Administrator access. For each user listed in the list labeled Users: on the left side of the panel, you can set this check mark to indicate that this specific user can now function as an administrator for the eSuite WorkPlace Administrator, in addition to the default admin and root users.

3.2.4 Java Security

When you select the Lotus eSuite WorkPlace in the Desktop setup task, before the main WorkPlace Administrator panel gets displayed, you may get a set of Java Security panels where a Java application or applet is asking for certain privileges, such as:

- Displaying windows that do not have the unsigned applet label
- Reading information stored in your computer, such as user name
- Modifying sensitive information stored on your computer
• Contacting and connecting with other computers on the network

This is caused by the applet requiring to display such things as a splash screen, pulling down JAR files from the server, setting some browser preferences possibly and contacting the server.

![Java Security Panel]

Figure 29. Java Security Panel

A click on **Certificate** displays the certificate from Lotus Corporation as illustrated in the next figure.
Figure 30. Certificate for Lotus Development Corporation

A click on Remember decision avoids these panels the next time you enter the WorkPlace Administrator through NSM. This certificate can always be removed as well later on if you wish to.

3.2.5 Adding Users to the eSuite Registry

Any user of the Lotus eSuite WorkPlace Desktop must first be added to the eSuite Registry in order to be allowed to use the desktop. The only exception is the users called admin and root (for AIX), which have been added by default to permit an initial use of the WorkPlace desktop by an administrator.

Users need to be added because the eSuite desktop can be customized for each user, in terms of the application categories and tasks that appear on the user’s desktop, and each user must therefore be identified in the eSuite Registry.

There seems to be basically three ways that users and groups get added to the eSuite Registry:

1. Users and groups were present in a previous version of the eSuite Registry and were migrated into the new version.

2. Users are imported into the eSuite Registry using the Import Users... function of the eSuite WorkPlace Administrator, which is new in Release 1.5.

3. Users are added automatically to the eSuite Registry when, in NSM, you configure a user to have the eSuite desktop and either that user logs on to a Network Station or the eSuite WorkPlace Administrator is started from within NSM and the user defaults level is used to enter data specific to that user.

3.2.5.1 Adding Individual Users

In Release 1.5, users can no longer be added individually to the eSuite Registry using the WorkPlace Administrator as was the case in the previous release.
Users can now only be added by being added to the server first (for example, using User Manager for Domains in Windows NT) and then being either specifically imported into the eSuite Registry from the WorkPlace Administrator by using the Import Users function or being added automatically when logging on to use the eSuite desktop or being defined in NSM as eSuite users.

3.2.5.2 Importing Users and Groups
Since users and groups can now only be added on the server, which facilitates the administrator’s job by having only one source of users and groups, an Import Users facility is provided in Release 1.5 of eSuite to import and synchronize the list of users defined in the server with those defined in the eSuite Registry.

To import users, on the Users tab of the WorkPlace Administrator panel, click on Import Users... located at the bottom of the panel.

Note: You cannot use the Import function if you started the WorkPlace Administrator as an application launched from the server (using the ewadmin batch file or the Shortcut icon). You must launch the WorkPlace Administrator either from NSM or from the eSuite WorkPlace Desktop on a Network Station to be able to use this function.

After clicking on Import Users..., the user is asked for a password, which is the same password that was used to log on to NSM, and then a progress panel is displayed indicating that the NSM database was queried, and the status while processing groups and users.

This is illustrated in the next figure:
Figure 31. The Import Users Function

The next figure illustrates an example of the groups that are present in the eSuite Registry before the Import function, the list of groups as they appear in the Windows NT User Manager for Domains, and the list of groups as they appear after the Import function completes.

Group names cannot have imbedded blanks in the name, which is why groups like Power Users and Backup Operators for example do not get imported. These groups are the same groups that you see if you use the browse function within NSM to list the available groups.
3.2.5.3 Synchronizing Users and Groups

During the Import User processing, the Import function verifies if there are groups and users that are present in the eSuite registry that are no longer present in the server database.

This could happen if a copy of the eSuite Registry has been migrated from a previous release or if groups and users have been deleted from the server database since the last Import function.

When it finds discrepancies between the two databases the groups and users are listed in a panel such as the one illustrated in Figure 33 on page 46.

The administrator then has the choice of deleting selected groups and users from the eSuite Registry. Unless there are some special reason for keeping these groups and users that are no longer in the server database, they should be deleted in order to maintain a single list of groups and users.

As the instructions on the panel indicate, selected users and groups are deleted when OK is selected. Unselected entries are not deleted.
3.2.5.4 Add Users Automatically
The easiest way in fact to add users to the eSuite Registry is to let the system do it automatically.

Once the user is defined on the server (and that can be a local user definition or a user defined in a primary domain controller’s global group which is made part of the local NSMUser group on the server), if the user is defined as having the eSuite desktop, the user is automatically added to the eSuite Registry when that user logs on to use the desktop.

A user is also automatically added when the administrator uses NSM to make this user an eSuite user or to make him or her part of a group that has the eSuite desktop as a configuration item.

This is the easiest and most efficient way of adding users to the eSuite Registry. In fact, if these users are all defined in a PDC as opposed to a local server, this may be the only way to add them to the eSuite Registry (see the following section).

3.2.5.5 Limitation of the Import Users
If you have an environment where your eSuite server is a stand-alone server attached to a domain and your users are defined on a primary domain controller, and where you have added these users to the server’s local NSMUser group by
making a domain's global group part of the local NSMUser group, these users cannot be imported into eSuite with the Import Users functions; however, these users can be added automatically to the eSuite Registry when they are defined in NSM as eSuite users.

In other words, the Import Users function of the WorkPlace Administrator can only import users from a local group on the server where it is operating. Therefore, even though you can log on from a Network Station using a user that is defined at the PDC level, you cannot import that user into eSuite.

The diagram in the next figure attempts to illustrate this environment.

![Diagram](image)

*Figure 34. Local Groups vs. Global Groups*

In the above diagram, Userx is defined locally, on server1, in the NSMUser local group. On the other hand, user1 and user2 are defined on the primary domain controller in a global group called NSMACCT.

By using the User Manager for Domains on server1, the administrator can add to the NSMUser local group all the users that are defined in the NSMACCT global group on the PDC by adding the NSMACCT global group to the NSMUser local group on server1.

The procedure to do this is illustrated in the next figure. On server1, use User Manager for Domains and open the NSMUser local group.

Click on **Add**, and on the Add Users and Groups panel that opens, use the drop-down list labeled List Names from to select the domain **NSDOMAIN**. The groups and users from the NSDOMAIN domain appear in the window labeled Names; select the **NSMACCT** group and click on **Add**. This causes the entry **NSDOMAIN\NSMACCT** to appear in the Add Names: window at the bottom.
When you are finished selecting groups and users to add, click on **OK** at the bottom of the Add panel (not shown in this figure) to complete the process. The last panel at the bottom of the figure just displays the contents of the global group called NSMACCT.

Therefore, when user1 logs on to server1 from a Network Station, the local SAM database is queried and user1 is found to be a member of that group; a verification is done with the PDC to ascertain that this user is still valid (it could have been deleted from the domain’s global group) and the user is allowed to log on.

However, when the administrator uses the Import Users function of the eSuite WorkPlace Administrator on server1, none of the domain’s global group or users are visible to the Import function and therefore cannot be imported. In the example above, only userx, which is defined locally, can be imported.

However, if you use an NSM function to configure a user, when you use the Browse function to see a list of users, all users that are included in the NSMIUser local group through the use of a PDC global group are visible and selectable.
that case, as in our example above, User1 can be selected, and configured as an
eSuite desktop user, which causes User1 to be automatically added to the eSuite
Registry.

3.2.6 Multiple Servers Environment

Since Network Station Manager Release 3.0, there is a possibility of using
multiple servers to support Network Stations, such as a boot server, a
configuration server, an authentication server, a DHCP server, etc.

For more details on this function, please refer to the "Separation of Servers"
chapter in the redbook entitled IBM Network Station Manager Release 3 Guide
for Windows NT, SG24-5221.

eSuite WorkPlace also brings another server called a registry server, which
provides a configuration file to register users and groups and the tasks that each
user or group is allowed to use.

By default, eSuite assumes that all the server functions are performed on the
same server. If you install eSuite in an environment where you are using multiple
servers, you must install eSuite on two servers, that is, it must be installed on the
boot server and on the authentication server.

There are two important points to remember:

1. eSuite must always be installed on the boot server because that is where all
   the Java classes reside and are downloaded from by the Network Station.

2. The eSuite registry is by default on the authentication server since this is
   where the Network Station users are defined.

   If you want to use the eSuite Registry on the boot (base code) server instead,
   you must manually edit the esuite.nsl file to reflect that change.

   To manually edit the esuite.nsl file, which is located in
   \station\prodbase\configs, open it with an editor such as Notepad, locate the
   Duser.home.server parameter which is set to 0.0.0.0 by default and change
   0.0.0.0 to the IP address of the base code server.

   See 5.1.1, "Processing of the esuite.nsl File" on page 101 for a look at the
   esuite.nsl file.
Chapter 4. Customizing eSuite Applications

After configuring using the Network Station Manager and the eSuite WorkPlace Administrator, the eSuite WorkPlace can be successfully started on a Network Station and most applications can be used without any additional configuration steps.

However, there are a few applications that require customization before they can be used. In other words, all applications are available for selection by the user on the eSuite desktop, but some of them are not functional without a few more customization steps. For example:

- The Mail task cannot be used without configuring a mail server. This can be done in advance by the administrator or by the user the first time he or she uses the mail application.
- The Web Browser task can be used if it does not require any proxy server to access the desired URLs. For access to the Internet using proxies, the proxies need to be specified.
- The Address Book task can be used as is. However, if access to address books other than a personal address book is required, the Light Directory Access Protocol (LDAP) must be customized to specify an LDAP server.
- Finally, if one desires to change the default file names used to store the user’s personal address book data, the calendar events and meetings, these names can be optionally be changed to a name chosen by the user.

To customize these applications, in the WorkPlace Administrator panel, click the Software tab, then in the Configure Software section in the bottom left-hand corner of the panel, click on Group Defaults..., which brings up the panel displayed in the next figure:

*This applet has not been customized for the All Users (Default) group.
In the Select a group column, click on the **All Users (Default)** group (or more groups if you wish since more than one can be selected), then in the Software to customize list, select the particular entry that you want to customize and click on **Customize**.

Software can also be customized for one or more individual users; in this case, use the User Overrides... button instead of the Group Defaults... button on the previous panel.

In the panel above, there are six entries that are selectable for customization. The diagram in the next figure summarizes what these customization selections actually consist of.

In the above figure, the LDAPSource Manager customization basically identifies where the LDAP server is located so that the address book task can establish a session with that server.
The MailSessionManager customization basically identifies where the incoming mail server and outgoing mail servers are as well as the protocol to be used with these servers.

The applicationServicesManager customization identifies the location of the server where the Lotus Application Services application resides.

Finally, the entries called messageSourceMgr, addressSourceMgr and eventSourceMgr allow you to change the default file names used to store the meetings data, address book entries and calendar events, respectively.

4.1 Customizing the eSuite WorkPlace Desktop

The eSuite desktop itself can also be customized in terms of the number and type of categories that appear on the desktop, and the order that the tasks appear within a specific category.

A maximum of 12 categories can be displayed on the desktop, each with a maximum of three tasks listed. If there are more than 12 categories, scroll bars appear allowing the desktop to be scrolled.

If there are more than three tasks in a category, a small triangle appears at either the bottom or the top of the list of tasks indicating that there are more than three tasks, and the user can click on the small triangle in order to scroll the list of tasks.

The number of categories that is displayed on a particular user’s desktop is driven by the number of tasks that have been assigned to this user. In other words, if a task that belongs to the Calculating category is configured as being available to user1, then user1’s desktop contains the Calculating category; if no task from the calculating category is configured as available to user1, then the calculating category is not be displayed on the desktop.

The main desktop customization tasks that the administrator performs consists mainly of deleting or adding categories and tasks, and assigning these tasks to groups and users.

In the customization examples that we use in this chapter, we are creating new tasks and adding these tasks to a new category we call Test Applications, so let’s create a new category to illustrate the process.

On the main Administrator Workplace panel, select the Categories tab and click on Add New Category... to display the following panel.
Enter the name you choose for the new category; we used Test Applications. Optionally, you can enter the name of a file representing the icon that you want to use to represent this new category; if not specified, the default icon used is the same as the one used for the Work Files category. Click on OK.

Note: <Desktop.Images> in the icon field represents the path to the normal locations of all the gif files for the icons; in Windows NT, this path is \\station\prodbase\esuite\com\lotus\desktop\main\images.
Back on the Categories tab of the main panel, the Test Applications category should now appear in the list of categories on the left side of the panel.

In the panel shown in the above figure, this category already contains three tasks (Java Clock, Lock Screen and Telnet W3) because we captured this panel after adding these tasks to this category; these examples (of adding these tasks) are described in 4.5, “Customizing Network Station Native Applications” on page 71.

Notice that on this screen, we have also added text in the field called Bubble help; this text appears when the mouse is moved over the icon representing this category.

This is also where you can select the sequence of the tasks as they appear within the category. In this example, we have elected to put the Java Clock task as the first one and the TelnetW3 as the last one. To change the order, use the arrows on the right side of the task list.

4.2 Customizing the Browser Task

Customization of the browser task consists mainly of specifying proxies (if access outside of a firewall is required) and setting a default search engine.

To set proxy servers for all users, on the WorkPlace Administrator panel, select the Groups tab and in the Select a group list, click on All Users (Default), and on Group Settings at the bottom of the Groups list, which brings up the following figure:
In the above panel, you are by default positioned at the Proxy Configuration tab; use the drop-down list that appears just below the word Servers, where the entry Inherit proxy settings from group hierarchy is currently showing and select the Connect through proxy server entry. In order to open up the proxy fields, enter the proxy information valid for your site.

This opens up the HTTP, HTTPS and Socks fields in which you can enter the name of a proxy host and the port to use on that host and click on OK.

A proxy is required when your company’s network is isolated from the Internet by a firewall and you need to provide your users access to the outside world while shielding them from that world. That is done by a proxy server, which in fact acts on your behalf to access outside resources.

This is illustrated in a simplified fashion in the next figure, where the esuite browser user in the bottom left-hand corner of the diagram, when accessing the your.company.com server on the intranet, can have a direct session with that server since it is inside the company.

However, when the eSuite user wants to access the www.abc.com server, it cannot do so directly because that server is outside the company’s network. In
that case, we specify that the browser should use a proxy, and give the address of the proxy.server machine as the proxy machine.

The request goes from the eSuite user to the proxy machine, which terminates the user session in the proxy.server machine; the proxy server then establishes its own session with the www.abc.com server, and acts as a go-between for the duration of the session. The www.abc.com is only aware of the proxy.server machine and not of the eSuite user machine.

Figure 41. Using a Proxy

Note: With Release 3, a Socks server can now be specified. However, be aware that the following note is included in the readme file concerning the use of a Socks server:

NOTE: Using a Socks server as your proxy affects all socket communications. If socks is configured, the Mail client tries to establish a connection to your mail server via socks. This enables you to reach your mail servers (i.e. IMAP4, POP3) outside a firewall. If your mail server is inside the firewall, it stops working once it establishes socks communication, and it displays an error message.

Figure 42. Socks Server Note from the Readme File
4.3 Customizing the Mail Task

The Mail task is the only task that will not function without some specific customization.

Like other tasks, customization can be done at a group level, where you enter settings that are applicable to a whole group and at an individual user level where settings specific to a particular user are entered.

In this example, assume that our mail server is called itsowts.itso.ral.ibm.com, that it is a POP3 mail server and that it is used for both incoming and outgoing mail. Further assume that we have two eSuite users, Mary Jones and Bill Smith, who are using this mail server.

Let's take a look at the group customization first. On the WorkPlace Administrator panel, click the Software tab, then in the Configure Software section in the bottom left-hand corner of the panel, click on Group Defaults..., which brings up the following panel:

In the Select a group column, click on the All Users (Default) group (you can select more than one group), then in the Software to customize list, select MailSessionManager and click on Customize to bring up the next panel:
The settings made in the above panel apply to all users. Some of the settings are:

- **Mail Server Path** is the fully qualified IP host name of the server handling incoming mail. In this example, our mail server is itsowts.itso.ral.ibm.com.

- **IMAP4 or POP3** chooses a mail protocol. Post Office Protocol 3 merely sends and receives mail without any management whereas IMAP4 supports mail folders for categorizing the mail and also allows drafts.

- **SMTP Server path** is the fully qualified IP host name of the Simple Mail Transfer Protocol server handling outgoing mail. In this example, we use the same server for incoming and outgoing mail.

The other settings are more applicable to individual users than to a group, as we show further down.

After entering the data, click on **OK**, and then on **Done** back on the Customize software panel.

Then select the User Overrides... button on the Software tab of the main WorkPlace Administrator panel, select one user (in this example we selected user...
Mary Jones) from the Users list, select MailSessionManager in the Software to customize list and click on Customize.

This brings up the panel shown in the next figure which is labeled Customize software for User, indicating that the data we enter here applies only to a user.

![Customize Software for User](image)

Some of the data we would typically enter here is:

- Name is the name of the user associated with the e-mail address specified a couple of fields down from this one.
- Login name is the user ID used to log into the mailbox on the mail server.

If this information is not entered on this panel by the administrator, the user is prompted the first time the mail application is used for this data.

After the user enters the data, it is saved and used the next time that the user calls the mail application if the user preferences are set to save this data. See Figure 112 on page 115, where the panels for setting user preferences are illustrated; on the tab labeled Management, there is a Skip mail login check box that can be selected. Note that the Log in automatically check box in the MailSession Manager in the WorkPlace Administrator must also be checked for this to take effect.

The name used in this field depends on the type of mail server used:

- In this example (data in the above panel), the server is a Microsoft Exchange server that belongs to an NT domain called NSDOMAIN. The
user name is Mary Jones, her Windows NT user account is MaryJ and her mailbox alias is MaryJ.

Her login name is therefore Domain_Name\NT_User_Name\Alias_Name, which is this case translates to NSDOMAIN\MaryJ\MaryJ. See 4.3.1, “Defining Users on the Mail Server” on page 62 for a brief explanation of how users are defined on a mail server.

• If a Domino server is used instead, the login name might be Mary Jones/IBM - ITSO Raleigh in the case where the domain is called IBM - ITSO Raleigh.

• E-mail address is the fully qualified e-mail address on the mail server but is optional. In this case, we omitted it.

• Log in automatically prevents the user from being prompted for this mail configuration information every time the user starts the mail task.

In other words, the data provided the first time by the user is used in subsequent logins to the mail server, except for the password. Even with this entry selected, the user is still prompted for the password.

If the user desires to have an automatic login, including the password, in order to avoid any prompt when he or she starts the mail task, he or she must then set his or her user preferences to indicate that the login name and password should be saved for use the next time the mail application is started.

See Figure 112 on page 115, which shows where this user preference can be set by a click on the Skip mail login box.

Therefore, both the Log in Automatically check box in the Mail Customization panel must be set by the administrator and the Skip mail login box in the user preferences set for saving the login name and password in order for the user to benefit from an automated login without a prompt for login name or password.

If you want the user to be able to switch mail servers or login name, do not use automatic login so that the user is prompted for the data every time he or she starts the mail task. The prompt panel that the user is presented with is shown in the next figure:
The user can change any data on this panel and then click on **Connect** to establish a connection to the server.

**Note:** Even if the user is logged on as Mary Jones on the Network Station and the eSuite desktop, he or she can, if presented with this panel, specify that he or she wants to access Bill Smith’s mailbox, and as long as the proper password is used, access to that other mailbox is permitted. In other words, the mail application user ID that you use does not have to be the same as the Network Station user ID or the eSuite user ID.

### 4.3.1 Defining Users on the Mail Server

The subject of how to install and administer a mail server is outside the scope of this document. Typically, you obtain the mail server configuration data from the administrator who is responsible for managing the mail server. However, we thought it might help to show examples of how a user is defined on a mail server as it relates to the data that you need to configure in eSuite.

#### 4.3.1.1 Microsoft Exchange Server Example

The first example is the definition of our sample user Mary Jones on a Microsoft Exchange server. The mail server administrator panel is illustrated in the next figure:
In the figure above, we are working with users that are part of the NSDOMAIN Windows NT domain. To add our Mary Jones user, we select **Recipients**, and then use the **File** pull-down and select **New Mailbox**, which brings up a panel such as the one shown in the figure below:
In the panel above, we enter Mary Jones, and an alias of MaryJ gets automatically assigned while the Windows NT account (which can be created from this panel also) is MaryJ.

Consequently, the login name to be used by this user when logging in to this mail server is NSDOMAIN\MaryJ\MaryJ and the password is the password entered in the Windows NT user account.

4.3.1.2 Lotus Domino Server Example

If we use a Domino server instead to accomplish the same steps, the procedure is as follows.

We use a Notes client to access the server, and choose File => Tools => Server Administration to access the Administrator panel, as illustrated in the next figure:

![Figure 49. Accessing the Server Administration Function in Notes](image)

This brings up the following panel:
On the above panel, click on **People** and then select **Register a person** to get the following panel:

![Register Person Panel](image)

**Figure 50. Notes Administration Panel**

Ensure that the Registration server shows the proper server, and click on **Continue**... to bring up the next panel.
Enter the user name and password and click on Register.

Next, open the address book in Notes to verify that the person has indeed been added.

Notice in the panel above that the E-Mail address for Mary Jones is Mary Jones/IBM - ITSO Raleigh, which is the name to use in the Login name field of the eSuite Mail Task.

Double-click on the Mary Jones entry, and then click on Edit to get the following panel:
Specify a password in the HTTP password field, and save your changes. The password gets encrypted and user Mary Jones can now access her mail. This is the password that you use on the password field in the eSuite Mail task. These were just two examples to show that the login name that must be used on the eSuite mail task can be different dependent on the type of mail server that you are accessing.

4.4 Customizing LDAP

LDAP stands for Lightweight Directory Access Protocol and it is a protocol used by a client to communicate with a server on which a Name and Address directory (Address Book) resides to be used by the client.

In the case of the eSuite Address Book task, it has its own personal address book, which is stored in the user's home directory on the boot server (the default file name is address.kox), and in which the user can create and store his or her own personal name and address entries.

The Address Book task also offers, through LDAP, the possibility of accessing one or more remote address books, such as a corporate address book for example, located on a remote server. The customization that is required in the case of LDAP consists mainly of identifying where the remote server(s) is located.

Once a user has access to remote address books, he or she can select entries in these remote address books and copy them into his or her personal address book, as needed.

To customize LDAP, on the main WorkPlace Administrator panel, click the Software tab, then in the Configure Software section in the bottom left-hand corner of the panel, click on Group Defaults..., which brings up the following selection panel:
In the Select a group column, click on the All Users (Default) group (you can select more than one group), then in the Software to customize list, select LDAPSourceManager and click on Customize, which brings up the next panel.
In the panel illustrated above, click on **Add...** and enter a Friendly name that the user will recognize. In this example we used Company Directory to mean that this is the company-wide address book. This Friendly name is the name that appears in the user’s address book task as a selectable entry when the user wants to look up names. This is illustrated in Figure 57 on page 70 where you see the entry Company Directory under the entry Personal.

Enter also the IP host name of the server where the address book is located. In this example, we used the same server as the mail server.

The port on the server is 389 by default as this is a well-known port for LDAP.

The next figure illustrates the relationship between the three entities involved, that is, the eSuite WorkPlace Address book task, the eSuite WorkPlace Administrator customization panel and the LDAP server configuration.
The bottom of the diagram shows the three entities concerned: the user on the Network Station using the eSuite WorkPlace, the eSuite Registry on the boot server where the eSuite WorkPlace Administrator is used to enter the customization data, and the LDAP server where the remote address book resides. On each of these entities is shown one of the panels.

The leftmost panel in the figure shows a section of the address book task panel that the user sees. At the bottom, notice that there are two entries appearing: one called Personal and the other one called Company Directory.

The Personal selection is always there and represents the user’s local personal name and address book, but the second selection (Company Directory) only
appears when the LDAP has been customized and a Friendly name entered, as shown on the panel in the middle of the figure entitled Customize Software for group All Users.

When the user wants to select names from the Company’s name and address directory, he or she clicks on the Company Directory entry, enters a name when prompted, and the entry from the remote directory on the LDAP server is displayed, at which time he or she can click on the Add to Address Book button if he or she wants to add this entry in his or her own personal address book.

The panel in the top right-hand corner of the figure is the LDAP configuration panel, in this case on a Microsoft Exchange server, where the administrator enables the LDAP protocol. The other tabs allow configuration of other LDAP-related parameters.

By default, on the exchange server, whatever entries appear in the Global Address Book are the entries available to the eSuite users through LDAP.

### 4.5 Customizing Network Station Native Applications

New with eSuite Release 1.5 is a category of tasks called Network Station. This category contains tasks that are native Network Station applications, such as:

- Start the 3270 Emulator
- Start the 5250 Emulator
- Start the NC Navigator Browser

Up to now, the user could launch these applications from buttons located on the Network Station menu bar, which meant that the eSuite user had to toggle back and forth between the eSuite desktop and the Network Station desktop in order to launch these native applications.

These native tasks can now be launched directly from the eSuite desktop because they are defined as eSuite tasks and are available, by default, from the Network Station Category, as illustrated in the next figure.

![Figure 58. The Network Station Category of Tasks](image-url)

The small triangle pointing downwards at the bottom of the list of tasks in the Network Station category indicates that there are more tasks in the list.
These tasks prompt the user for a host name or URL at the time that they are started. However, these tasks can be customized to launch a session with a specific host, with specific parameters or to go to a specific URL.

4.5.1 Customizing a Start the 3270 Emulator Task

Below is an example where we customize the Start 3270 task to go to a specific host, and we give this task the name MyNew3270.

The procedure is as follows:
1. Start the WorkPlace Administrator and click on the Task tab and click on the Add New Task button at the bottom of the list of existing tasks to get the panel displayed in the next figure.

![Add Task Panel](image)

2. In the panel above, enter a chosen task name, such as My New3270, click on the radio button labeled **Launch an application without a document**, click on the Native radio button, use the drop-down list to select 3270 Emulator (in this case the default), enter the file name of an icon that you want to use to represent this task when it is opened (we used the default icon_greenscreen.gif) and click on Set Task Properties.

Figure 59. Add Task Panel

3270 Emulator
**Note:** The Desktop.Images selection, before specifying the name of the gif file for the icon, represents a path to where many of these icons are stored, which is `\station\prodbase\esuite\com\lotus\main\desktop\images` (in Windows NT). You can select an icon that already exists in that directory or you can store your own icons in that location.

![Add Task](image)

3. In the Set Task Properties panel above, enter the string `commandParameters` in the Property field, and in the Value field, enter the destination host name followed by any other parameters that are allowed on the `ns3270` command.

   In this example, we specify the `-debug` flag to get additional messages on the Network Station console and we specify the `-graphics` flag to indicate that we want a session that supports GDDM graphics.

   Then click on **Set**, which causes these entries to be added to the window above the entry fields. Click on **Close** to return to the Add Task panel, and click on **OK**.
4. Back on the main Task panel, the new task now appears in the list of available tasks (under Select a task), but the WorkPlace category displays as Uncategorized (under Set task options).

   Use the drop-down list and select the category **Network Station**.

5. If you now select the **Categories** tab, you should see a panel as displayed in the next figure.
On the Categories panel, select the **Network Station** category (under Select a WorkPlace category) and you should see your new task appear in the list task order in this category, where you can choose to modify the order of the listed tasks.

6. There is one last step required, which is to assign this new task to either a specific user or to a group.

Assume, for the sake of the example, that this new task is applicable only to one user. Click on the **Users** tab to get the following panel:
In the leftmost column (under Select a user), select the user to which you want to assign this task, and in the rightmost column (under Assign tasks to user), select the **MyNew3270** entry and click on **Assign**.

A small single figure icon appears next to the entry to indicate that this task is assigned to a specific user.

If you perform a similar assign action under the Groups tab, the added icon would be the multiple figures icon, as shown on all the other tasks in the list shown here, to indicate a group assignment.

7. As a result of the actions above, when the user Ariane S. logs on and gets the **eSuite desktop**, this MyNew3270 task should appear in the **Network Station** category as illustrated in the figure below:
For other users, this MyNew3270 task does not appear under the Network Station category because we assigned it only to this user.

4.5.2 Adding a Lock Screen Native Command Task

In this example, we want to add a Network Station native application that can be launched from the eSuite desktop. In fact, the application is a Network Station native command called Lock Screen which allows the user to lock his or her screen when leaving his or her workstation for a while.

In summary, the steps we need to perform are as follows:

1. Add new software. This actually creates and defines the actual command so that it can later be selected and assigned to a task.
2. Add a new task. This operation actually creates the task itself and defines what software is used when this task is executed.
3. Assign the task to a category. This operation determines the category to which this task belongs. If it is not performed, the task appears under the uncategorized category.
4. Assign the task to group(s) or user(s). Finally, this operation determines which users/groups have access to this new task. The task can be made available to all users or restricted to a single user, and all variations in between.

The following steps illustrates adding this new task.

4.5.2.1 Adding New Software

To add new software, bring up the WorkPlace Administrator and select the Software tab, as illustrated in the figure below:
On the panel shown above, clicking on **Add New Software...** displays the panel in the next figure:
On the Add Software panel illustrated above, click on the radio button labeled **No registration file** and enter the name that you want to use to describe this particular software entry in the software title field. We choose to call this **Lock Screen**. This is the name that will appear later when we make a selection among all of the available native software (as shown on page 82).

Then click on the radio button labeled **Native application**, enter the command as it is expected by the native Network Station (in this case the command is simply `lock screen`) in the field labeled Command and click **OK**.

**Note:** In the version we were using, when we clicked on the No registration file radio button, we expected the cursor to be positioned in the Software title field so that we could enter data; however, the cursor remained positioned in the URL field above but, in reality, it was actually positioned at the right location but was invisible. Therefore, just go ahead and start typing the entry you need in the Software title field.
On return from the Add software panel, the Software tab panel should appear as shown below:

4.5.2.2 Adding a New Task
We then need to create a new task. Select the Task tab on the Administrator Workplace, as shown in the figure below:
Figure 68. The Tasks Tab of the Administrator WorkPlace

On the panel above, clicking on **Add New Task...** displays the panel shown below:
In the panel above, in the field labeled Name, enter the name of the task as you want it to appear when it is listed on the eSuite WorkPlace desktop in one of the categories. In this example, we use the same name we used when we created the software entry, that is Lock Screen.

Then click on Launch an application without a document, click on the radio button labeled Native, use the drop-down list to display the software that can be assigned to this task, select the Lock Screen entry and click on OK to bring back the main Task panel.

The name Lock Screen is the name we used when we previously created the Add Software function on page 79.

**Note:** In this case, we do not need to set any other task properties.

### 4.5.2.3 Assigning the Task to a Category

The next step is to assign this new task to a specific category.
Figure 70. Assigning a Task to a Category

Back on the main Task panel as illustrated above, notice that the Lock Screen task now appears under the Select a task list. In the Set task options section of the panel, use the drop-down list called WorkPlace category and select the **Test Applications** category (or whatever category you want).

**Note:** If you are using the WorkPlace Administrator from within Network Station Manager and you experience problems changing the Uncategorized entry to the category you select in the drop-down list, a bypass that you can use is to perform this function by starting the WorkPlace Administrator either from the server directly (NT and AIX) or from an eSuite WorkPlace Desktop until this problem is fixed.

You can also optionally assign a particular icon to represent this task by specifying the file name of a GIF file in the field that appears below the radio button labeled Specify filename for custom icon. If you leave the entry blank, a default icon is used.

If you want to verify that this assignment was indeed done, click on the **Categories** tab of the WorkPlace Administrator to display the categories, as shown in the next figure:
4.5.2.4 Assigning the Task to Groups and Users

The last step we need to perform is to assign this task to either groups or individual users.

In this example, we simply assign this task to all users by assigning it to the group called All users. Click on the Groups tab to display the next panel:
Under Select a group, select the **All Users** group, select the **Lock Screen** task under the Assign tasks to group, and click on **Assign**.

An icon with three little figures appears beside the Lock Screen task to indicate that this task is now assigned to a group. If the task is assigned to a single user instead, the icon that appears beside the task is a single figure icon.

Now that we are finished, how does this appear on the desktop? The next figure illustrates the Test Applications category as it appears in the eSuite desktop.
In the figure above, the Test Applications category appears on the desktop and it currently contains two tasks, the Lock Screen we just added and the Java Clock which we describe later in this chapter.

See 4.1, “Customizing the eSuite WorkPlace Desktop” on page 53 for an example of how to add a category, such as the Test Applications category we use in this example.

The icon that was used for the category is the default icon since we did not specify any particular icon when we defined the category.

4.5.2.5 Using the Lock Screen Task
If the user clicks on the Lock Screen task, the eSuite desktop disappears and the panel shown in the next figure is displayed:

![Figure 74. The Lock Screen Function](image)
The user enters a password, then is asked to re-enter to ensure that the password was entered correctly, and the a small caption appears to say that the screen is locked.

To unlock, the user must enter the same password that was just entered. This password is not stored anywhere and the user can use a different one each time if he or she wishes. After unlocking the desktop, the eSuite desktop re-appears and the user can continue working from the desktop.

The advantage of having this command available directly from the eSuite desktop is that the user does not have to use the Network Station menu bar.

4.5.3 Adding a Telnet Task

Another native Network Station application that might be very useful is the ability to start a telnet session with a remote host.

If there is an application that is UNIX-based for example and you want to provide users access to this application directly from the eSuite desktop, you can add a task to perform this function.

The steps are identical to the ones we just described above for adding the Lock Screen command, so we do not repeat here all the detailed steps but only the main ones.

In this case, assume that we need to establish a telnet session to a host called w3.itso.ral.ibm.com.

4.5.3.1 Add software

As we did for the Lock screen, the first step is to add a software entry, using the Add Software function, as illustrated below:
On the Add Software panel, click on **No registration file** and enter a name to describe the function. We used Telnet to W3. Click on **Native application** and enter the command (we used `telnet w3.itso.ral.ibm.com`) and click on **OK**.

**Note:** We are making this software entry very specific by entering the destination host in addition to the command telnet. We could have entered only the command telnet and later on, in the task definition step, we can use the Set Task properties to actually specify the destination host. The advantage is that the same software entry can be used by multiple tasks when only the destination host differs. On the other hand, it is simpler to enter the destination here because it avoids an additional step when defining the task.

### 4.5.3.2 Add Task

The next step is to add a task. From the Tasks tab, click on **Add New Task**... to display the next panel:
In the Name field enter the task name you want to use. In this example, we used TelnetW3. Click on Native and select the Telnet to W3 software that we just defined in the previous step and click on OK.

**Note:** Notice again here the Set Task properties... button that we could have used instead to specify a destination host in the case where we had elected to add a software that was more generic and contained only the telnet command without any destination host specified. We provided an example of this in this chapter when we created a new 3270 session task (see 4.5.1, “Customizing a Start the 3270 Emulator Task” on page 72).

**4.5.3.3 Assign the Task to a Category and Users**

Finally, assign this task to a category. In this case, we added it to our Test Applications category, just like the Lock Screen task, and made it available to all users.
4.5.4 Adding a Java Applet Task

Here is also an example of adding a Java applet to the eSuite Desktop.

In this case, we use the Java Clock sample applet that comes with the JDK and we add this applet to our Test Applications category on the eSuite desktop.

Once more, the steps are nearly identical to the two examples we just described (Lock Screen task and Telnet task) so we do not repeat the detailed steps. The main difference in this case is that this is a Java applet as opposed to a native Network Station command.

4.5.4.1 Add Software

As usual the first step is to add a software entry by clicking on the Add software button on the Software tab of the Administrator WorkPlace panel, which displays the panel in the next figure:

![Add Software (Java Applet)](image)

Figure 77. Add Software (Java Applet)
In the field labeled Codebase directory at the top of the panel, enter the path of where the applet is located. The <Base.Root> entry represents the eSuite root, which in the case of Windows NT for example is x:\instation\prodbase\esuite.

The entry you make in the field is therefore relative to this base. In this example, we located the applet in a directory called \instation\prodbase\esuite\applications\javademo\clock, so we only need to enter applications\javademo\clock\ as the path relative to the Base.Root.

Then we click on No registration file and enter a name in the field labeled software title; we choose to use Java Clock as the name. Then click on Class name and enter the name of the class, which in this case is Clock2, and click on OK to terminate.

This brings back the main tab labeled Software, which should now appear as illustrated in the following figure:

![Figure 78. The Software Tab after Adding Java Clock](image)

Notice in the panel above that the Java Clock software now appears in the selectable software list and that the launching class is identified as well as the location of the class.
4.5.4.2 Add a Task

Next, click on the Tasks tab and on Add New Task... to display the following panel:

![Add Task Panel](image)

Enter the name that you want to use for the task (we used Java Clock in this example) in the Name field, click on Launch an application without a document, click on Registered (as opposed to Native as we did in all the other examples) and use the drop down list to select the Java Clock entry (this entry becomes available in the registered list after the software was added in the previous step), and click on OK.

4.5.4.3 Assign The Task to a Category and Users

Finally, as we did before, assign this task to a category. In this case, we also added it to our Test Applications category, just like the Lock Screen task and the Telnet task, and we made it available to all users.
4.5.4.4 Executing the Java Clock Applet
Once the Java Clock is available on the desktop, clicking on the task produces the following output:

![Figure 80. Executing the Java Clock Sample Applet from eSuite](image)

4.6 Customizing eSuite Application Services
As mentioned in the introduction when discussing the new functions provided by eSuite 1.5, a separate product called eSuite Application Services is available that provides eSuite WorkPlace users with the ability to view non-eSuite files as well as perform spell checking on eSuite files.

The eSuite Application Services product must be installed on a Windows NT server. It can be installed on the same server as the eSuite WorkPlace on any other Windows NT server.

4.6.1 Limitations
There are limitations however as to where this product can be installed, the most important one being that it cannot be installed on a server where Lotus SmartSuite is already installed. Please consult the product’s Readme file, of which we have provided some extract in Appendix B, “Lotus eSuite Application Services Readme” on page 163.

4.6.2 eSuite Application Services Installation
The installation process for eSuite Application Services is fairly simple and similar to other products. Please consult the readme file for details.

At the end, the installation process writes a file called esuitefactory.ior and prompts the user for the location of (where to write) this file.

This file contains the interoperable object reference address of the eSuite Application Services just installed; among other things, the IP address of the server where it was just installed is coded in that file, and this file is used as input to the customization process on the eSuite WorkPlace.

You can write this file to a diskette, and carry the diskette to the server where eSuite WorkPlace is installed, or you can write it to a local drive and directory,
share this drive and directory and access it as a remote drive from the server where you are customizing eSuite WorkPlace.

**Note:** For the AS/400, the only available procedure is to save the file locally on the Windows NT server where the eSuite Application Services are being installed and use FTP to transfer the file to the /QIBM/ProdData/eSuite directory on the AS/400 where the eSuite WorkPlace is installed.

When the installation process completes, reboot the server. After the server restarts, you should see the following messages appear in a window on the server, indicating that the eSuite Application Services are ready to receive requests from remote users:

![Lotus eSuite Application Services](image)

Figure 81. eSuite Application Services Startup Messages

### 4.6.3 Customization Steps

In order for eSuite users to access the eSuite Application Services, the following customization steps must be done using the eSuite WorkPlace Administrator:

1. In eSuite WorkPlace Administrator, click on the **Software** tab, then click on **Group Defaults**... in the bottom left corner of the panel, in the section entitled Configure software.
2. In the Customize Software for Group panel illustrated in the next figure, in the column labeled Select a group, select the group or groups (multiple selections are allowed) to which you want to give access to the eSuite Application Services. Select **ApplicationServicesManager** in the Software to customize list on the right side of the panel, and click on **Customize**.
In the next panel, enter the path and name of the file that was created during the installation process for the eSuite Application Services and click on **OK**.

In this example, we copied the file to a diskette, so we specify `a:\esuitefactory.ior`. If the file resided on a remote drive, the drive and directory for the remote file would be used.

A confirmation window appears when the file is found. Click on **OK**, and then on **Done**.

If you click again on the **Customize** button after the IOR file has been read, the following panel is displayed, indicating the address of the server where the eSuite Application Services are installed and the name of the service it is configured for.

**Note:** If the IP address of the server where the Application Services reside is changed, the IOR file must be recreated so that this new address is reflected, and the customization process performed again on the eSuite WorkPlace server.
4.6.4 Setting the Spelling Dictionary

Now that eSuite Application Services have been customized, eSuite users have access to these services.

The panel in the next figure is a partial panel from the Writing task, showing the Edit pull-down options where the Set spelling dictionary... and Check spelling... entries appear.

A click on Set spelling dictionary... causes the Application Services server to be contacted. If the server was not installed properly, or is unavailable, a message indicating that the server cannot be contacted is displayed.

If the server is available and the customization was done properly, the panel shown in the next figure is displayed, allowing the user to set the spelling dictionary.
4.6.5 Customizing the Default Filenames

Referring to Figure 37 on page 52, under Software to customize, the entries called messageSourceMgr, addressSourceMgr and eventSourceMgr, when selected, allow you to change the name of the files used to store the meetings data, address book entries and calendar events, respectively.

As shown in the diagram, these files reside on the boot server in the user’s home directory located in ..\station\userbase\home\"username". The file names shown here as addressdef.kox, eventdef.kox and msgdef.kox are the default file names used.

The next figure shows these files as they appear in the user’s home directory on the boot server.
The following three figures illustrate the panels that are displayed when you click on Customize for any of these three entries.

**Figure 89. The User's Home Directory**

**Figure 90. The messageSourceMgr Customization Panel**

**Figure 91. The eventSourceMgr Customization Panel**
To change any of these file names, enter a new name and click on **OK**.

There is actually no need to change any of these names unless you have a problem with the default filename used.
Chapter 5. Using The Lotus eSuite WorkPlace 1.5 Applications

The objective of this chapter is to provide a quick introduction to the applications (called tasks) available from the eSuite desktop, mainly to make the reader aware of these applications as opposed to providing a tutorial on the operation of each of these applications.

In general, most actions are fairly straightforward and somewhat intuitive, as these applications have been designed to be simple to use.

5.1 Starting the eSuite WorkPlace Desktop

How does the user start the eSuite WorkPlace desktop on the IBM Network Station?

Actually, the user typically does not have to specifically start the eSuite WorkPlace desktop because it is started automatically when the user logs on to the Network Station, if the user is defined as an eSuite user in NSM (in other words, if this user has been configured in NSM as having an eSuite desktop; see 3.1.6, “Configuring the Desktop in IBM Network Station Manager” on page 27).

In fact, it is the Network Station Login client (actlogin is the actual name of the module that gets launched as part of the boot sequence of events) that verifies whether the user is an eSuite user or not. It determines this by looking at whether this user has been configured in NSM as requiring a Lotus eSuite WorkPlace desktop; if it has, a variable called NSM_TASKBAR is set to the value ESUITEYES and this is what triggers actlogin to load the eSuite WorkPlace.

5.1.1 Processing of the esuite.nsl File

Loading the eSuite WorkPlace desktop takes place when the actlogin module processes the esuite.nsl configuration file. The figure below illustrates the contents of the esuite.nsl file.

```
!NSM Release 3.0, PTF 2, run command for eSuite 1.5(5648KN3)
RUN java -mx16m -ms16m -my1m -mr400k -msy4m -msr2m -sync_gc \
    -classpath /netstation/prodbase/java/classes.zip:/netstation/prodbase/eSuite: \
    /netstation/prodbase/eSuite/com/lotus/jars/hotjava.jar \
    -verifyremote \ 
    -Duser.home.server=0.0.0.0 \ 
    -Dawt.frame.topInset=0 \ 
    -Dawt.frame.bottomInset=0 \ 
    -Dawt.frame.leftInset=0 \ 
    -Dawt.frame.rightInset=0 \ 
    -Duser.base=file://localhost/netstation/prodbase/eSuite/ \ 
    -Dworkplace.platform=NetStation \ 
    -Dncd.NSM.TASKBAR=${NSM_TASKBAR} \ 
    -Dncd.NSM.HTTPPORT=${NSM_HTTP_PORT} \ 
    -Dncd.auth.server=${AUTHENTICATION_HOST} \ 
    com.lotus.desktop.launcher.WorkPlace
```

Figure 93. The esuite.nsl File Contents
In the figure above, notice the first line which states NSM release 3.0, PTF 2, run command for eSuite 1.5. If you have migrated from a previous release of eSuite and the desktop does not come up as it should, verify that the esuite.nsl file contains this statement. If it does not, it may be that you have an old version of the esuite.nsl file because the migration process did not work correctly.

The second line that begins with RUN java actually starts a java application on the Network Station, which is what the eSuite desktop is, and specifies a few parameters.

The third and fourth lines (which actually are normally on one line that has been split here in order to be able to show it all) specifies the classpath parameter, that identifies to path to the java class.

The next eleven lines are parameters (called Properties sometimes) to be passed to the java application upon starting.

Finally, the last line is the name of the java class to be executed.

The backslashes that appear at the end of the lines in esuite.nsl indicate a continuation of the command.

Finally, notice the parameter -Duser.home.server, which is set to 0.0.0.0. Before the actlogin module processes the esuite.nsl file, if this parameter is set to 0.0.0.0, it replaces this value with the contents of the AUTHENTICATION_HOST variable that contains the address of the authentication server, which is where the eSuite Registry is normally located. If you are using separation of server and wish to have the eSuite Registry on the base code server instead, this is the parameter that needs to be changed to the address of the base code server.

Once the desktop is up and operational, there is an item on the menu bar of the Network Station labeled eSuite that can be used to relaunch the eSuite WorkPlace desktop in case it was manually closed by the user.

5.1.2 Desktop Startup Duration

Even on an IBM Network Station Series 1000 with the maximum memory located on a high-speed TRN network, the loading time for the eSuite WorkPlace Desktop is fairly significant initially as it loads all of the Java functions and required modules.

If you want a visual indication that the launching is actually taking place, start the IBM Network Station console (use the Alt+Shift+Home key combination, or Pause, or whatever key combination has been defined by the administrator) and monitor the messages being issued as the Java launching activities take place. See Figure 123 on page 128 for a sample message log of an eSuite desktop startup.

If messages stop being issued and a desktop does not appear in a reasonable amount of time, you are likely to be experiencing some configuration problem.

The default standard desktop that gets displayed is similar to the one displayed in the next figure:
On the panel above, tasks that the user can perform are grouped into categories of tasks. Each category can contain one or more tasks. If there are more than three tasks in a category, there is a small downward triangle on which you click to scroll the tasks list.

The categories that are displayed on the desktop, and the list of tasks included in each category is configured using the WorkPlace Administrator.

Multiple tasks can be started and these tasks then appear as a small icon and text on the left-hand side of the panel where the user can switch from one to the other by selecting each task.

The entire eSuite desktop can be minimized by using the small arrow pointing down located on the bottom left-hand corner of the desktop. Minimizing the desktop is used when the user needs to access other native Network Station applications and functions.

The next figure illustrates some of the controls available on the main desktop.
When the user closes the eSuite desktop and there are still active tasks opened, the status of the active tasks is recorded so that they can be restarted automatically the next time the user starts the eSuite desktop, thereby positioning the user back at the point where he or she was at the time that he or she closed the eSuite desktop.

### 5.2 Using the Web Tasks

The Web browser integrated into the eSuite WorkPlace is based on Sun’s HotJava browser and provides most of the functionality of most popular browsers.

Note that there is no support for JavaScript, and therefore, this browser cannot be used to access the Network Station Manager application on the server.

A click on the **Search the Web** task, located in the **The Web** category (bottom left-hand corner of the main panel, as illustrated in Figure 94 on page 103), displays the panel illustrated in the next figure:
Figure 96 is the browser interface, which has accessed the default URL of the AltaVista search engine.

Notice that a small icon has appeared on the left-hand side of the desktop representing this task.

Some of the controls at the bottom of the Web browser are illustrated below. All are pretty self-explanatory. The Go to button allows you to enter a specific URL whereas the Web Search button calls the pre-configured URL for the search engine, such as AltaVista.
5.3 Using the Work Files Tasks

The Work Files task allows the user to access his or her own personal files and documents stored on the server.

Any document the user creates is stored on the server in his or her user home directory. By using the All Files task, the user gets a listing of all his or her files and directories. A click on any document automatically launches the application required to process that document.

The user can alternate between All documents, Recent documents or Find a specific document by using the buttons at the bottom left-hand corner of the panel illustrated below.

```
<table>
<thead>
<tr>
<th>All Folders</th>
<th>Contents of User files</th>
</tr>
</thead>
<tbody>
<tr>
<td>User files</td>
<td></td>
</tr>
<tr>
<td>Login</td>
<td>Name</td>
</tr>
<tr>
<td>My Foils</td>
<td>Login</td>
</tr>
<tr>
<td>My Spreads</td>
<td>My Foils</td>
</tr>
<tr>
<td>Trash</td>
<td>My Spreads</td>
</tr>
<tr>
<td></td>
<td>Trash</td>
</tr>
<tr>
<td>addrdef</td>
<td>addrrdef</td>
</tr>
<tr>
<td>eventdef</td>
<td>eventdef</td>
</tr>
<tr>
<td>msgdef</td>
<td>msgdef</td>
</tr>
</tbody>
</table>
```

From the bottom of the panel, clicking on File allows typical file operations such as Copy, Move, Rename, Delete, and clicking Type allows you to specify the type of files that you want to display. (The default is All files.)

This is illustrated in the next figure.
The next figure shows the same directories and files that we see in Figure 98 on page 106 as they are stored on the server in the user's home directory. On a Windows NT server, the directory is \station\userbase\home\"username".

Figure 100. User Ariane's Home Directory
5.4 Using the Calendar Task

This task provides common calendar functionality. It is also a straightforward and simple application that requires very little explanation as every action is sort of intuitive.

The task is illustrated below, with a few entries shown for a typical day.

You can select a month by clicking on the desired month in the top right-hand corner of the panel.

Any single day is also displayed by a simple click on the desired day.

To make an entry in a day, at a specified time, double-click anywhere on the time slot that you want to fill. A start time and duration appears, allowing you to expand or contract the duration and to enter an activity.

When making an entry for a meeting, you can also automatically send a message to a specific user’s e-mail address by a click on the small icon next to the OK button (not illustrated here).
5.5 Using the Calculating Task

The Calculating task is a spreadsheet application similar to Lotus 1-2-3 or Microsoft’s Excel that provides common spreadsheet functionality.

It supports the @ functions, sorting, file import/export, cell formatting and images.

It does not require any customization.

Figure 102. The Calculating (Spreadsheet) Task

Clicking on Properties or Number format brings up the panel in the next figure, where multiple tabs are presented for selecting different settings.

Figure 103. Spreadsheet and Cell Properties Choices
5.6 Using the Presenting Task

The Presenting task is a subset of Freelance Graphics that supports SmartMasters, templated pages, drawing tools, clip art, screen show and file import/export. It does not require any customization.

Figure 104. The Presenting (Graphics) Task

Figure 105. Some of the Presenting Task Functions
5.7 Using the Writing Tasks

The Writing tasks allows the user to use a word processor that provides common word processing functionality such as text attributes, tables, and images.

**Figure 106. The Writing Task**

Additional functions are available via Properties and other buttons.

**Figure 107. Writing Task - Properties**
5.8 Using the Address Book Task

The Address Book task provides common address book functionality. It provides a detail and list view of address information and it supports the import of vCard data as well as other contact information.

The address book data is accessible from other tasks, such as the mail task, in order to select names and corresponding e-mail addresses for example.

The display can be toggled between a list of names or a display of the details for one entry.

![Figure 108. The Address Book Task](image)
5.9 Using the Mailbox Tasks

When the user clicks on one of the Mailbox tasks, either My Mail or New e-mail message, he or she might see, the first time around, a prompt panel asking for a login name and password, such as illustrated in Figure 46 on page 62.

After a login name and password have been entered, and server addresses have been entered if these have not already been pre-configured, the user can click the Connect button to cause the mail application to contact the mail server. The user should then see the main mail application panel being displayed, as illustrated in the next figure.

The user can set preferences such that the login name and password are saved and used automatically the next time the mail application is started.

In the example shown in the next figure, the mailbox folder happened to contain one message when the user started the mail application and the message is therefore downloaded and displayed automatically.

![Figure 109. The My Mail Application Panel](image)

A click on Options gives the user the choices illustrated in the next figure.
The user can also manually check for new messages by clicking on the Mail button, as shown in the next figure and then selecting **Check for new messages**.

A click on **Mail => Preferences...** brings up the next series of panels where one panel is selected with a click on the appropriate tab.

Notice that one of the preferences, under the Notification tab, is the frequency at which the mailbox is checked for new messages, which is set to 5 minutes.

Notice as well, under the Management tab, that you can set the Skip mail login check box in order to ask to save the login name and password so that the user does not have to supply these every time he or she starts the mail application.
Clicking on **Mail => System information** also displays a series of panels showing some of the current system settings for the mail application, as illustrated in the next figure.

**Figure 112. Mail Preferences**
### Figure 113. Mail System Information

<table>
<thead>
<tr>
<th>User Information</th>
<th>IMAP Server</th>
<th>POP/SMTP Servers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail server login: IBM - ITSC</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td>Mail server password: *****</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td><strong>IMAP Configuration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full name:</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td>IP address: itsowts.itso.ralemb.com</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td>Port: 143</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td><strong>SMTP Configuration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full name:</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td>IP address: itsowts.itso.ralemb.com</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
<tr>
<td>Port: 25</td>
<td>POP/SMTP Servers</td>
<td></td>
</tr>
</tbody>
</table>
5.10 Using Network Station Native Applications

With eSuite Release 1.5, Network Station native applications such as the 3270 Emulator, 5250 Emulator and the NC Navigator can now be launched directly from the eSuite desktop.

These tasks are in a new category called Network Station, as illustrated in the next figure.

A click on **Start the 3270 Emulator** brings up a small panel prompting the user for a host name to connect to, and then the traditional 3270 emulator session panel comes up in the eSuite WorkPlace desktop presentation space, as illustrated in the next figure.

The next figure displays the NC Navigator panel.
Figure 116. Start NC Navigator Task
Chapter 6. Basic Problem Determination

This section provides additional details on some of the configuration issues for cases where you need to investigate a bit further when your installation or configuration is not successful the first time around.

For more details on how to use some of the problem determination tools on the IBM Network Station, please consult the redbook IBM Network Station Manager Release 3 Guide for Windows NT, SG24-5221.

6.1 Troubleshooting Domain Name Server Configuration

If you suspect that you have a problem communicating between the Network Station and the server or between the Network Station and other IP hosts, then one of the first items to investigate is the domain name server configuration information.

How do you find out what DNS information is configured? For those who may not be familiar with where to look for this information, here are a few examples applicable to a Windows NT server.

6.1.1 DNS Configuration on the Server

To find out what the current DNS information is on the Windows NT server, use Start => Settings => Control Panel => Network => Protocols, select TCP/IP and click on Properties, then select the DNS tab. This brings up the panel illustrated in the next figure.

Figure 117. Sample DNS Data Configuration on a Windows NT Server
In this case, the three important pieces of DNS configuration data are:

1. The IP host name (in this case itsowts).
2. The IP domain name (in this case itso.ral.ibm.com).
   This is the default domain name that is used if you issue any commands with a host name as the target and you do not specify a fully qualified host name including the domain name. So, if you issue ping host1, the command that is actually issued is ping host1.itso.ral.ibm.com.
3. The DNS Service Search Order is a list of the IP addresses of the host or hosts that are the DNS servers.
   The first DNS server listed is tried first and if it is not available, the next one in the list is tried.

The above configuration information is what allows this server to contact a DNS server and request to resolve an IP address into a host name.

On the server, the user can verify whether this mechanism is functioning properly by using the following commands:

- ping server
  A successful return from the ping command indicates that the IP host name "server" has been successfully resolved.
  What you should see displayed in the command prompt window is something like:
  
  Pinging server.company.com [x.x.x.x] with yy bytes of data
  Reply from x.x.x.x: bytes=yy time<10ms TTL=128

  When only the IP host name is used on a command, the default IP domain name (in this example company.com) that is configured on the server is appended to the host name specified on the command.

- ping server.company.com
  A successful return from the ping command indicates a proper resolve of the IP host name and domain name.

- ping -a IP address
  This should return the fully qualified IP host name while doing the ping, just as in the example above.

**Note:** This test using ping on the server indicates that the server has the proper access to a domain name server in order to correctly resolve IP host names and addresses. It does not confirm however that applications on the Network Station itself can also resolve names properly or that the eSuite browser can have access to addresses on the intranet or behind the firewall if the station is inside a company’s network, because the DNS configuration information may not have been transmitted correctly to the Network Station. To do a similar ping test on the Network Station itself, use the **Test Network** utility available from the **Utilities** pull-down of the Network Station console.

When you specify in Network Station Manager that you want the DNS configuration created by Network Station Manager, NSM creates a hosts.nsm file based on the server’s own DNS configuration. So, if we continue this example,
NSM on this server would create a hosts.nsm file that contains the statements as illustrated in the next figure.

```
#version R3M0
set tcpip-dns-default-domain="itso.ral.ibm.com"
set tcpip-name-servers={
 (*9.24.104.108*)
 (*9.14.1.30*)
}
set tcpip-name-local-cache={
 (*itsowts" 9.24.104.240" 0)
 (*itsowts.itso.ral.ibm.com" 9.24.104.240" 0)
}
```

Figure 118. A Sample hosts.nsm File

Notice that in addition to the default domain name and the list of the DNS servers' IP addresses, it has also included statements to set both the qualified and unqualified IP host names of itself (the server) so that references to these names by the Network Station do not have to be resolved since they are cached.

What about the situation where the Network Station uses DHCP to get its DNS information?

### 6.1.2 DHCP DNS Configuration

If the DNS information is transmitted to the Network Station using DHCP, then you must verify the DHCP configuration file on the DHCP server.

If the DHCP server is a Windows NT Server with IBM's DHCP server, use Start => Programs => eNetwork On-Demand Server => DHCP Server Configuration to bring up the panel illustrated in the next figure.
Figure 119. IBM DHCP Server Main Configuration Panel

On this panel, find the client representing the Network Station that you are working with. (In this example, we called it STATIONA). When you select this client the options that are to be transmitted to this client are displayed in the bottom portion of the panel.

In the panel above, you can see that option 6 (Domain Name Server) identifies the list of the DNS servers (9.24.104.108 and 9.14.1.30), and option 15 (Domain Name) is set to itso.ral.ibm.com.

If these options are not defined at the client level, then they can be defined at the subnet level or at the global level. You can verify this by selecting the subnet and/or the global level to display the options configured at those levels.

Once this information has been transmitted to the Network Station via either the hosts.nsm file or the DHCP server options, how can you verify, on the Network Station itself, that this DNS information is correct?
6.1.3 Network Station’s DNS Configuration

This is certainly not a typical user task, but we assume here that you are the administrator, that you are having problems with a specific station and that you need to verify that the configured information on the station is the correct one.

We give you only a summary here; for more details on how to do problem determination on the Network Station, please refer to the IBM Network Station Manager Release 3 Guide for Windows NT, SG24-5221.

The easiest way is to verify the setting of a few specific parameters (such as the ones that have been identified in the sample hosts.nsm file illustrated in Figure 118 on page 121) is to remotely access the configuration daemon on the Network Station and display the current settings of a few parameters.

To do this, from either the server or any PC on the network with telnet facility, issue the following command, where x.x.x.x is the IP address of the Network Station:

```
TELNET x.x.x.x 5999
```

When asked for a password, use the word public since you only want to display the settings and not set them. To set them, you would need to know either the unit global password or the configuration read-write password.

You could issue the command GET ALL, to see a list of all the parameters, but this is such a long list (over 700 parameters), that this is overkill. Instead, issue the command GET GROUPS, which gives you the list of all the groups of parameters, which consists of only about 40 names.

This allows you to then pick the name that you want in case you do not know or remember the name of the group of parameters. In our case, the group name we are interested in is called tcpip.

You can then issue the following command, which displays a list similar to the one illustrated in Figure 119 on page 122:

```
GET TCPIP
```

We have identified in bold the parameters that have been set by the hosts.nsm configuration file.

If you do not want to see all the parameters of this group but only those that you want, use the command get parameter-name, for example get tcp-name-servers, as long as you know the exact name of the parameter.
This is the easiest and fastest way of verifying the settings of these parameters on the Network Station. However, if you are at the Network Station itself, you can also view these parameters directly by using the **Setup** pull-down on the Network Station console, selecting **Setup Parameters**, and then the section called **TCP/IP name service**.

This displays a panel as illustrated below:
In the panel above, the DNS Default Domain is identified at the bottom of the panel (itso.ral.ibm.com), the DNS servers are in the Name Servers list (9.24.104.108 and 9.14.1.30) and the Local Name Cache contains the names that were in the list of cached names, in addition to any other host names that have been resolved since boot time.

### 6.1.4 Displaying the IP Routing Table

Finally, it is nice to verify that one or more DNS servers are properly specified, but you might also have to verify that these servers can actually be reached.

This of course is highly dependent on the configuration of your overall network and where the different servers are located relative to the Network Station that you are using, so one thing you might have to verify is that the IP routing table on the Network Station contains the required entries to allow it to reach the DNS servers.
You can display the contents of the IP routing table by doing a telnet to port 5999 and using the command get ip-routing-table. This should give you a display similar to the one shown below, where the Network Station is on a 9.24.104.0 subnet with a subnet mask of 255.255.255.0 and its gateway is the host called WTR6611A:

```
*** NCD X Terminal Configuration ***
Password:
> get ip-routing-table
ip-routing-table = {
  # { 9.24.104.0 itsonctl.itso.ral.ibm.com 0 static local 125 -1 network 0 xffffff00 }
  # { 0.0.0.0 WTR6611A.itso.ral.ibm.com -1 static local 125 -1 network 0x0 }
  # { 0.0.0.0 itsowts -2 static local 125 -1 network 0x0 }
  # { 127.0.0.1 localhost 0 static local 818 -1 host 0xffffffff }
}
```

Figure 122. A Sample IP Routing Table on the Network Station

Typically, you access the rest of the network through a default gateway and that default gateway must therefore be present in the routing table.

6.1.5 Troubleshooting AS/400 Problems

If you encounter problems bringing up the eSuite WorkPlace, registry servers, or the eSuite WorkPlace Administrator on an AS/400, check the following:

1. Verify that the registry servers are running (issue the WRKACTJOB command) and make sure there are processes running for the Java RMI registry server (QESRRMI) as well as the eSuite registry server (QESRSVR).

2. Check the User Services Console messages on the IBM Network Station. This console can be displayed by pressing the ALT+Shift+Home keys.

3. If a log is needed of the eSuite Registry server, use the QESUITE/STRESRSVR OPTION(*KEEPLOG) command to start the registry servers. Keep in mind that the server issues constant messages, so this should only be done for debugging.

4. If the eSuite WorkPlace Administrator does not come up the first time, verify you are logged in as admin.

5. If you have reinstalled any of the Lotus eSuite Workplace (5648KN3) prerequisite products (5648C05 or 5769JV1) or applied PTFs for these products, you may need to have a system operator perform the following steps:
   - End the eSuite registry server using the QESUITE/ENDESRSVR command. If the RMI server was started by the STRESRSVR command, it will be running in the QESRRMI job in subsystem QSYSWRK. You need to end QESRRMI using the WRKACTJOB command and option 4.
   - Execute the following command to reestablish the original eSuite install configuration:

```
CALL QESUITEC/QESRINSX
```
6.2 Sample Message Logs (Startup and Shutdown)

If this is the first time that you are attempting to bring up the eSuite WorkPlace desktop on the Network Station and it is not coming up, one of the first places to check for error messages is the message log on the Network Station.

We have reproduced in the next two figures some of the typical messages that you should see in the message log when eSuite comes up and when it is shutting down.

This is only to provide you with a reference point to the messages that you might be getting.
Figure 123. Sample Message Log on eSuite 1.5 Startup (1 of 2)
The next figure shows some of the messages issued when eSuite is terminated.

It is important to have a normal shutdown because eSuite saves the status of the
desktop (you should see a message that indicates that the desktop was
successfully saved) so that it can be reset to the state it was in the next time you
start eSuite.
Figure 125. Sample (Edited) Message Log on eSuite 1.5 Shutdown

[ Logoff in progress. Please wait... ]
[ Stopping Task: 6096450, IBM Lotus eSuite WorkPlace for ADMINISTRATOR ]
[ Terminating Task: 6096450, IBM Lotus eSuite WorkPlace for ADMINISTRATOR ]
[ Stopping Task: 6096450, IBM Lotus eSuite WorkPlace for ADMINISTRATOR ]
[ Active WorkPlace tasks saved ]
[ Terminating Task: 5892692, Event Source ]
[ Stopping Task: 5892692, Event Source ]
[ Terminating Task: 5892737, Message Source ]
[ Stopping Task: 5892737, Message Source ]
[ Terminating Task: 5957802, Address Source ]
[ Stopping Task: 5957802, Address Source ]
[ Terminating Task: 5957892, Mail Source ]
[ Stopping Task: 5957892, Mail Source ]
[ Terminating Task: 5957847, LDAP Source ]
[ Stopping Task: 5957847, LDAP Source ]
[ Terminating Task: 5957937, Mail Session Manager ]
[ Stopping Task: 5957937, Mail Session Manager ]
[ Terminating Task: 5978376, default ]
[ Stopping Task: 5978376, default ]
[ Terminating Task: 5987163, 5 ]
[ Stopping Task: 5987163, 5 ]
[ Terminating Task: 5987181, default ]
[ Stopping Task: 5987181, default ]
[ Terminating Task: 5999517, default ]
[ Stopping Task: 5999517, default ]
[ WorkPlace state saved successfully. ]
[ Logoff complete ]
Appendix A. Installing/Configuring eSuite Release 1.0

This appendix provides step-by-step instructions on how to install the eSuite WorkPlace Release 1.0 and on how to use the Network Station Manager Release 3.0 and the eSuite WorkPlace Administrator 1.0 applications to configure the elements necessary to be successful in starting the eSuite WorkPlace 1.0 on a Network Station.

A full example is provided for the Windows NT platform but instructions are also provided for platforms other than Windows NT. These instructions have been copied from the readme files applicable to each platforms but they have not been tested as the Windows NT instructions have; however, the configuration and customization steps are the same for all platforms as only the actual installation process is different.

We are providing these instructions here, which are applicable to Release 1.0 of eSuite, because they differ, albeit only slightly, from Release 1.5; they already existed at the time that Release 1.5 became available, and since there might be cases where Release 1.0 is still required, before moving to 1.5, we have elected to supply these instructions in this Appendix.

A.1 Summary of Installation and Configuration Steps

For those who may require only a very brief list of steps with minimal instructions, we provide here a summary checklist where each step can be marked as complete after it is performed.

If you require additional details and examples on how to accomplish each of these steps, you can find examples and additional instructions in the next chapter.

<p>| Table 3. Summary of Installation and Configuration Steps for eSuite 1.0 |
|------------------|------------------|</p>
<table>
<thead>
<tr>
<th>Check</th>
<th>Step</th>
<th>Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On the server</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Read the readme file pertinent for your platform.</td>
<td>The readme file contains the latest instructions, based on the version that you are using, and should always be consulted first.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Verify the prerequisites.</td>
<td>Before you proceed, verify that you have all the prerequisites for your particular platform.</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Install eSuite on the server.</td>
<td>Insert the CD and follow instructions, which are simple and straightforward.</td>
</tr>
</tbody>
</table>
### Installing and Customizing Lotus eSuite WorkPlace 1.5 for IBM Network Stations

<table>
<thead>
<tr>
<th>Check</th>
<th>Step</th>
<th>Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Create a group (use any name you wish, for example esuite) on the server.</td>
<td>This group is used for all eSuite users. <strong>Note</strong>: If all Network Station users are all eSuite users, this step is optional and you can use the NSMUser group instead of creating a new group, or you can configure all settings at the system defaults level in NSM instead of using a specific group.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Create a user called admin on the server.</td>
<td>This user name is required in order to do the first logon to the eSuite WorkPlace Administrator.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Make the user called admin a member of the NSMUser group. This group name may be applicable to Windows NT only.</td>
<td>This is optional if you log on to the WorkPlace Administrator on the server using the ewadmin command (NT and AIX only). On the AS/400, this is required.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Create other eSuite users, as needed and add them to the NSMUser (Windows NT) group as well as to the group you created in step 4. Users logging on to a Network Station must be members of the NSMUser group.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Using Network Station Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Start Network Station Manager.</td>
<td>In your browser, use URL = //server/networkstation/admin, where server is the IP host name or address of the server where NSM resides.</td>
</tr>
<tr>
<td>9</td>
<td>Configure the DNS information for all stations (assuming that this has not already been done).</td>
<td>In NSM, select <strong>Hardware =&gt; Workstations =&gt; System Defaults</strong>, click on Next, then scroll down to Domain Name Server and select one of the two buttons, dependent on whether you use DHCP or not, and click on Finish.</td>
</tr>
<tr>
<td>10</td>
<td>Configure the Network Station desktop for eSuite users.</td>
<td>In NSM, select <strong>Startup =&gt; Menus</strong>, enter the group name you created in step 4 in Group Defaults, click Next, and in the section called Desktop and Menu Bar Options, use the Desktop Style drop-down list, select <strong>Lotus eSuite WorkPlace with menu bar</strong>, and click on Finish.</td>
</tr>
<tr>
<td>11</td>
<td>Configure the time zone (TZ) environment variable.</td>
<td>In NSM, select <strong>Startup =&gt; Environment Variables</strong>, enter the group name you created in step 4 in Group Defaults, click Next, in the field called Environment variable, enter the value TZ, and in the Value field, enter EST (for Eastern Standard Time) or whatever the correct value is for your geographical location and click on Finish.</td>
</tr>
</tbody>
</table>
### Installing/Configuring eSuite Release 1.0

12. **Configure the Network Station user’s group.**

   - In NSM, select **Select User’s Group**, enter a user name or use Browse to select one from a list, click on **Next**, and in the field labeled Group to use for defaults for this user, enter the group name you created in step 4 (or use the drop down list and select the group from the list), and click on **Finish**.

---

### Using eSuite Workplace Administrator

13. **Start the eSuite Workplace Administrator and log on as user admin.**

   - Log on the server as user admin and use the ewadmin command (NT and AIX only), or log on to a Network Station with user name admin and use the Workplace Administrator task (required on the AS/400, optional on NT and AIX).

14. **Add eSuite users to the All Users group.**

   - **Note**: This is a mandatory step. Users must be added before they can use the eSuite Workplace.

   - On the WorkPlace Administrator main panel, click on **Users** on the left-hand side of the panel, click on the **Add...** button at the bottom of the Users list, enter the name of one of the user IDs that you defined in step 7 and click on **OK**.

   - Repeat for all users that need to use the eSuite Workplace.

15. **Customize the mail task.**

   - **Note**: This is a mandatory step to be able to use the mail task. However, customization can be done in advance by the administrator or it can be done by the user when he or she gets prompted for the address of the mail server(s) and user names, etc. when he or she first tries to use the mail application.

   - On the left side of the main WorkPlace Administrator panel, click on the **Groups** icon, then in the Groups list, select the **All Users (Default)** group, click on **Customize Software** in the bottom right-hand corner of the display, select **MailSessionManager** and click on **Customize**.

   - Enter the name of the mail server(s) valid for your site, provided by a network administrator and click on **Done**.

   - See A.9.2, “Customizing the Mail Task” on page 162 for details if required.

16. **Customize the browser, if a proxy is required.**

   - **Note**: If the Web browser is only used on the intranet, this step is not required.

   - On the left side of the main WorkPlace Administrator panel, click on the **Groups** icon, then in the Groups list, select the **All Users (Default)** group, click on **Customize WorkPlace** in the bottom right-hand corner of the display, click on the **Connect through proxy server** button to open up the fields below it, enter the proxy information valid for your site, and click on **OK**.

   - See A.9.1, “Customizing the Browser Task” on page 159 for details if required.
A.2 Prerequisites for All Platforms

Before you install the eSuite WorkPlace 1.0 on any server, please review the prerequisites discussed in the following sections in order to ensure a smooth installation.

A.2.1 Readme Files

In all cases, make sure that you consult the latest readme files available at http://boulder.service.ibm.com/nc to ensure that you have the latest information.

We have reproduced here, for your convenience, most of the information that is present in the readme files for the different platforms, but the information available on the Web will always be more current than this redbook.

A.2.2 Network Station Hardware

The minimum recommended IBM Network Station hardware for Lotus eSuite WorkPlace is a model 1000 with 64MB of RAM because this is what the product has been designed for.

A.2.3 Domain Name Server Configuration

eSuite needs to be able resolve the IP host name of the server by using both the fully qualified IP host name, for example server.company.com, and also the short form (unqualified IP host name), for example server. A domain name server must therefore be accessible by the Network Station that is running eSuite.

A.3 Installing eSuite WorkPlace 1.0 on a Windows NT Server

To install the eSuite WorkPlace on a Windows NT server, please follow the steps outlined below.

A.3.1 Windows NT Server Prerequisites

The prerequisites specific to a Windows NT server are:

• The IBM Network Station Manager Release 3 must be installed and functional on either a Windows NT Server 4.0 or Terminal Server Edition.

If this is not the case, please refer to IBM Network Station Manager Installation and Use, SC41-0664 product publication and to IBM Network Station Manager Release 3 Guide for Windows NT, SG24-5221 for instructions on how to install this product and for the prerequisites required by the Network Station Manager.

• The JDK 1.1.5 must be installed.

• A domain name server must be available on the network.

A.3.2 Using Previous eSuite Registry Information

If the eSuite installation process on Windows NT detects eSuite Registry information (that is, eSuite configuration information) from a previous eSuite installation, the administrator is prompted as to whether he or she wants to keep the existing eSuite Registry information or to discard it.

Typically, the existing information would be kept.
A.3.3 Installation Instructions

Insert the Lotus eSuite WorkPlace CD in the CD-ROM drive on the server and the InstallShield should be launched automatically. If not, type \"x:\pc\setup.exe\" where x:\ is the CD-ROM drive.

There is a readme.txt file in the root directory of the CD, but it is only a short pointer to the contents of the CD.

The real readme.txt file that we recommend you always read before proceeding with the installation is in the PC subdirectory on the CD. Some of the descriptions we give in this document are a repeat of the information that you can find in this readme file, although we have added here additional comments, explanations and illustrations.

The install process itself is fairly uncomplicated. The usual InstallShield panels are displayed, one of which is the destination directory prompt, as shown in the next figure:

![Image of destination directory prompt](image)

*Figure 126. Destination Directory - Lotus eSuite WorkPlace Installation*

If you attempt to install eSuite and you do not have the JDK 1.1.5 installed, the installation process issues a warning and terminates.

After the installation process ends, reboot the server to complete the installation.

A.3.4 Verifying the Installation

It is always a good idea to verify after an installation that all components were successfully installed. In this case, there are two primary items that you can verify:
1. NT Services

Examining the NT services (use **Start => Settings => Control Panel => Services**), you should see two new entries labeled Java RMI Registry and Lotus eSuite WorkPlace Registry with a status of Started, as illustrated in the next figure:

Both of these services are configured to start automatically. You should see after a reboot two command prompt entries on the task bar:

- One labeled `x:\jdk1.1.5\bin\rmiregistry.exe`
- One labeled `x:\jdk1.1.5\bin\java.exe`

These remain on the task bar all the time and represent the services that have been started. To eliminate these entries from appearing on the Windows NT task bar, select the service, click on the **Startup...** button and click off the box labeled **Allow service to interact with the desktop.** These services will still start but will not show up as tasks on the task bar.

2. System Variables

The following three variables are also added to your system variables:

- `DESKTOP_HOME`, which contains, for example, `d:\nstation\prodbase\esuite`
- `JAVA_HOME`, which contains, for example, `d:\jdk1.1.5`
- `HOSTNAME`, which contains the server’s IP host name

**A.3.5 Creating a User Called admin on the Server**

Later in the process, we will need to use a user called admin in order to initially access a configuration application called the eSuite WorkPlace Administrator. It is therefore probably a good time now to create this user ID on the server.

Since we may want to also use that user ID to log on to a Network Station, and use the WorkPlace Administrator from a Network Station instead of from the...
server (optional), make the user admin a member of the NSMUser group on the server.

A.3.6 Creating a New Group on the Server (Optional)

If all the Network Station users that are served by this server are also all eSuite users, then creating a new group on the server to identify the eSuite users may not be necessary.

That is, if all users are eSuite users, all the eSuite-related settings can be defined at the System defaults level in Network Station Manager and these settings then apply to all users. Another option is to use the existing NSMUser group to define the eSuite settings.

However, since it is likely that not all Network Station users are eSuite users, and the non-eSuite users do not require the eSuite WorkPlace desktop to come up automatically after logging on, it is preferable to define a group on the server that represents only the eSuite users, which is the method we use in the example given here. We create, in this example, a group called esuite that we use to configure the settings applicable only to the Network Station users that are eSuite users.

Before we can enter this group name in any of the IBM Network Station Manager configuration panels, we need to first create this group on the server. If this is not done first, NSM issues an error message when a group name that does not yet exist on the server is entered in an NSM panel.

Here is an example of how this is done on a Windows NT server, using the User Manager for Domains application. (Other platforms have different but similar procedures for creating a group.)

Use **Start => Programs => Administrative Tools => User Manager for Domains**, and select **Users => New Local Group** in order to bring up the panel shown below:

![New Local Group](image)

*Figure 128. Creating a New Group in Windows NT*

Enter a group name, such as esuite, and then click the Add button to bring up a list of the existing user names and select user names from the list in order to add them to this group.

In this example, let’s assume that we have two users, Ariane and Thomas, that are already defined as Network Station users. That means that they are already
members of the NSMUser group to allow them to log in from an IBM Network Station. We also make these two users members of the esuite group, as shown in the panel below:

![Local Group Properties](image)

Figure 129. Adding Members to the eSuite Group

A.4 Installing eSuite WorkPlace 1.0 on an AS/400 Server

The steps to install the eSuite WorkPlace on an AS/400 server are discussed in the following sections.

The readme file for the AS/400 platform is available on the web at http://service.boulder.ibm.com/nc/as400/r3/readme.as4.txt.

A.4.1 AS/400 Server Prerequisites

The following products need to be installed on the server before installing the eSuite code:

- OS/400 V4R2 or V4R3 & latest CUM Tape
- 5769JV1 - AS/400 Developer Kit for Java
- 5648C05 - IBM Network Station Manager Release 3.0
- 5769SS1 - PTF SF49066 for Security enhancements (V4R2 only)

A.4.2 Installation Instructions

To install the Lotus eSuite WorkPlace code:

1. If you have a previous version of eSuite WorkPlace installed, have all eSuite users log off and end the registry server using the QESUITE/ENDESRSVR command.

   If the RMI server was started by the STRESRSVR command, it will be running in the QESRRMI job in subsystem QSYSWRK. You need to end QESRRMI using the WRKACTJOB command and option 4. Before installing, ensure that both the QESRSVR and QESRRMI jobs have ended.

2. Insert the eSuite CD-ROM into the CD-ROM drive.
3. Enter RSTLICPGM LICPGM(5648KN2) DEV(<device name>) OPTION(*BASE), where
<device name> is the name of CD-ROM device, for example OPT01).
4. Enter RSTLICPGM LICPGM(5648KN2) DEV(<device name>) OPTION(1).
5. Enter RSTLICPGM LICPGM(5648KN2) DEV(<device name>) OPTION(2).

After the installation process completes successfully, the following PTFs need to
be installed on the server:
1. 5648KN2 - PTF SF50398 and PTF SF50399 for the following fixes:
   • STRESRSVR command failing when the library list of the job issuing the
     command contains a library that does not have PUBLIC *USE authority.
   • An incompatibility with eSuite WorkPlace 1.0 and JDK 1.1.6.
     • V4R2: The following set of V4R2 PTFs change the AS/400 JDK level to
       1.1.6, 5769JV1 SF49635, 5769JV1 SF49750, and 5769999 MF19586.
       If you load and apply these Java PTFs you must load and apply the
       eSuite PTFs 5648KN2 SF50398 and 5648KN2 SF50399 for eSuite to
       properly function.
       **Note**: These eSuite PTFs work with the AS/400 JDK level 1.1.4, as well.
     • V4R3: The AS/400 JDK level is 1.1.6, so these eSuite PTFs 5648KN2
       SF50398 and 5648KN2 SF50399 must be loaded and applied for eSuite
to function.

A.4.3 Verifying the Installation

Successful installation of the eSuite code makes the following configuration
changes to the AS/400 system:
1. The STRESRSVR and ENDESRSVR commands are added to the QESUITE
   library.
2. The QESUITE user profile is created.
3. The Lotus eSuite product files are copied to the AS/400 Integrated File
   System under /QIBM/ProdData/eSuite directory.
4. Previous eSuite registry data is preserved.
5. A symbolic link is added to the /QIBM/ProdData/NetworkStation directory:
   /QIBM/ProdData/NetworkStation/eSuite => /QIBM/ProdData/eSuite.

A.4.4 Manual Configuration on the AS/400

On an AS/400, a few additional steps are required before the eSuite WorkPlace
can be used:
1. Create an admin user profile using CRTUSRPRF USRPRF(admin)
   PASSWORD() USRCLS(*SECOFR) TEXT('eSuite administrator') filling in an
   appropriate password.
   This user called admin is required to log on to the eSuite WorkPlace
   Administrator.
2. Have the system operator or a user with *ALLOBJ special authority start the
   eSuite registry server using the QESUITE/STRESRSVR command.
3. Ensure the system value QUTCOFFSET is set correctly for your site. See the
   OS/400 Work Management (SC41-5306) publication for more information.
4. Start the RMI registry and eSuite registry server.

The RMI and eSuite registry servers execute on the AS/400 and need to be started prior to starting the eSuite WorkPlace.

Note that the eSuite registry server should be stopped prior to ending TCP/IP or powering down the system. If the RMI server was started by the STRESRSVR command, it will be running in the QESRRMI job in subsystem QSYSWRK. You need to end QESRRMI using the WRKACTJOB command and option 4. Before ending TCP/IP or powering down the system, ensure that both the QESRSVR and QESRRMI jobs have ended.

- To start the RMI and eSuite registry servers, issue the QESUITE/STRESRSVR command. A message indicating the eSuite registry server has started will be issued to the QSYSOPR message queue.
- To stop the eSuite registry server, issue the QESUITE/ENDESRSVR command.

5. Create a new group for eSuite users (optional).

If all the Network Station users that are served by this server are also all eSuite users, then creating a new group on the server to identify the eSuite users is not necessary.

That is, if all users are eSuite users, you can define all the eSuite-related settings at the System defaults level in Network Station Manager and these settings then apply to all users. Another option is to use the existing NSMUser group to define the eSuite settings.

However, since it is likely that not all Network Station users are eSuite users, and the non-eSuite users do not require the eSuite WorkPlace desktop to come up automatically after logging on, it is preferable to define a group on the server to represent only the eSuite users.

### A.5 Installing eSuite WorkPlace 1.0 on an AIX Server

To install the eSuite code on an AIX server, follow the instructions provided below.

#### A.5.1 AIX Server Prerequisites

On an AIX server, the following filesets need to be installed before installing the eSuite code:

- AIX 4.2.1 or higher.
- IBM Internet Connection.
- APAR IX70775, which can be downloaded from http://service.boulder.ibm.com/aix.ww/aixfixes. This is an APAR for AIX 4.2.1.
- Release 3.0 of IBM NSM code (base, Java, ibmlogin and NSM), which can be downloaded from http://service.boulder.ibm.com/nc/aix/
- JDK 1.1.4 (or higher) for AIX. (This has to be installed as an LPP.)
- 42MB of disk space on the AIX server.
A.5.2 Migrating from a Previous Release on AIX

Registry files will be preserved when installing eSuite over the version of eSuite for Release 2.5+.

User data in the/home/ directories will need to be manually copied over to the /usr/netstation/eSuite/nsm/users/ directory.

A.5.3 Installation Instructions

To install eSuite on an AIX server, follow these steps:

1. If you have a previous version of eSuite WorkPlace installed, have all eSuite users log off and end the registry server processes by issuing ps -ef | grep java to find the process IDs and then issuing kill -9 xxxx, where xxxx is the process ID for each registry server.

2. Insert the eSuite CD-ROM into the CD-ROM drive.

3. Issue the smitty install_latest command from the AIX command line and use /dev/cd0 as the device from which you are installing.

4. When prompted to specify the code you wish to install, press F4 to get a list of filesets to choose from, select netstation.eSuite.rte, and press Enter to proceed with the installation.

A.5.4 Verifying the Installation

A successful installation of the eSuite code makes the following configuration changes to the AIX system:

1. The /etc/inittab file is updated to automatically start the RMI registry and eSuite registry at system boot time. The file that contains these commands is /etc/rc.eSuite.

2. The file ewadmin is added to the /etc/ directory. This file is used to start the eSuite WorkPlace Administrator.

3. The eSuite product files have been installed in the /usr/netstation/eSuite directory.

4. The previous eSuite Registry data has been preserved.

5. The RMI registry and eSuite registry are automatically started when the AIX server is booted. You can verify that these registries are running by issuing the following commands, which should return with Bids for each process:

   ps -ef | grep NCS
   ps -ef | grep rmi

   If you need to manually start the registries, execute the /etc/rc.eSuite script.

A.5.5 Create a User Called admin on the Server

Later in the process, we will need to use a user called admin in order to initially access a configuration application called the eSuite WorkPlace Administrator. It is therefore probably a good time now to create this user ID on the server.

Since we may want to also use that user ID to log on to a Network Station, and use the WorkPlace Administrator from a Network Station instead of from the server (optional), make the user admin a member of the NSMUser group on the server.
A.5.6 Create a New Group on the Server (Optional)

If all the Network Station users that are served by this server are also all eSuite users, then creating a new group on the server to identify the eSuite users may not be necessary.

That is, if all users are eSuite users, you can define all the eSuite-related settings at the System defaults level in Network Station Manager and these settings then apply to all users. Another option is to use the existing NSMUser group to define the eSuite settings.

However, since it is likely that not all Network Station users are eSuite users, and the non-eSuite users do not require the eSuite WorkPlace desktop to come up automatically after logging on, it is preferable to define a group on the server to represent only the eSuite users, which is the method we use in the example given here.

A.6 Installing eSuite WorkPlace 1.0 on an OS/390 Server

To install the eSuite code on an OS/390 server, follow the instructions provided below.

Note: The software contained in this package applies only to OS/390 Version 2 Release 4 or later. It is not supported on earlier versions. The user who installs the code needs WRITE privileges to be able to create files and subdirectories under /usr/lpp/eSuite and /etc/eSuite. Also, a configuration file under /etc/nstation must be updated.

A.6.1 OS/390 Server Prerequisites

Release 3.0 of IBM NSM Code (base, Java, ibmlogin and NSM) JDK 1.1.4 (or higher) for OS/390 needs to be installed before you install the eSuite code.

The following amounts of space are required:

- 26MB of HFS data set space on the OS/390 system under /tmp for the pax file.
- 45MB of HFS data set space on the OS/390 system under /usr/lpp/eSuite for the exploded directory structure.
- 250KB of HFS data set space on the OS/390 system under /etc/eSuite for the eSuite directory structure. In addition, approximately 1.5KB of additional space is required per user and group. This additional space will vary, depending upon the tailoring that is performed in the eSuite WorkPlace Administrator for the users, groups and system preferences.

A.6.2 Installation Instructions

To install eSuite on an OS/390 server, follow these steps:

1. FTP the eSuite10.pax file from the CD to the /tmp directory of OS/390 system. The file should be transferred in binary. You will need space for a 26MB file.

2) Create the /usr/lpp/eSuite directory.

mkdir /usr/lpp/eSuite

3) Explode the eSuite10.pax file into the /user/lpp/eSuite directory.
cd /usr/lpp/eSuite
pax -pe -rvf /tmp/eSuite01.pax

4) Create the directory structure that contains the read/write eSuite registry at /etc/eSuite.

mkdir /etc/eSuite
cp -Rp /usr/lpp/eSuite/registry/ /etc/eSuite/registry/

5) Your NFS server is probably configured to use an exports file. You will need to update the exports file to list the eSuite code as a read only directory structure.

/hfs/usr/lpp/eSuite -ro

6) The Network Stations need to know that they should create a mount point for the eSuite code. You need to update the defaults.dft file in /etc/nstation/StationConfig/ to contain the necessary file system mount command.

This file is in ASCII. The simplest way to update the file is to download it to an ASCII-based system (that is, a PC) as a binary file so that no translation occurs then edit it on the system and upload it back to OS/390 as a binary file.

The following line should be appended to the defaults.dft file. Change the hostname value to be the host name of the OS/390 system (for example, st.clair.shores.ibm.com).

```
set file-service-table[-1]= { "/netstation/prodbase/eSuite/" nil hostname nfs "/hfs/usr/lpp/eSuite/" unix 3 30 8192 8192 }
```

**Note:** The data is shown on multiple lines in this document only for clarity. It must be added to the defaults.dft file as a single line.

### A.6.3 Starting the RMI Registry and eSuite Registry Server

It is recommended that the RMI registry and eSuite registry be set up to automatically start when OS/390 is IPLed. Consult the OS/390 manuals and your local operational guidelines for this procedure.

You can verify the registries are running by issuing the OMVS ps and grep commands.

```
ps -ef | grep NCS
ps -ef | grep rmi
```

These commands should return with PIDs for each process.

To manually start the registries, execute the /usr/lpp/eSuite/eSuite.sh script. This shell script uses three environment variables as overrides for the location of the Java, eSuite code, and eSuite registry directories.

- **$JAVA_HOME** is the location of JAVA. It currently defaults to /usr/lpp/java/J1.1.
- **$eSuiteRootPath** is the location of the eSuite code which you installed at /usr/lpp/eSuite. It currently defaults to this path. You should not change this value.
- **$eSuiteRegistryPath** is the location of the eSuite registry data. This is the directory structure that you created at /etc/eSuite/registry.
A.6.4 Create a User Called admin on the Server

Later in the process, we will need to use a user called admin in order to initially access a configuration application called the eSuite WorkPlace Administrator. It is therefore probably a good time now to create this user ID on the server.

Since we may want to also use that user ID to log on to a Network Station, and use the WorkPlace Administrator from a Network Station instead of from the server (optional), make the user admin a member of the NSMUser group on the server.

This admin ID is only required during the initial configuration and may be removed once the WorkPlace Administrator has assigned another OS/390 user ID as an administrator for eSuite.

A.6.5 Create a New Group on the Server (Optional)

If all the Network Station users that are served by this server are also all eSuite users, then creating a new group on the server to identify the eSuite users may not be necessary.

That is, if all users are eSuite users, you can define all the eSuite-related settings at the system defaults level in Network Station Manager and these settings then apply to all users. Another option is to use the existing NSMUser group to define the eSuite settings.

However, since it is likely that not all Network Station users are eSuite users, and the non-eSuite users do not require the eSuite WorkPlace desktop to come up automatically after logging on, it is preferable to define a group on the server to represent only the eSuite users, which is the method we use in the example given here.

A.7 Configuring eSuite 1.0 Using Network Station Manager

Before an IBM Network Station user can actually use the Lotus eSuite WorkPlace there are a few configuration tasks that need to be performed using the Network Station Manager.

A.7.1 Starting the Network Station Manager

The IBM Network Station Manager is accessed using a browser, either on the server itself or from any location that has access to this server.

The URL is: http://server/networkstation/admin.

On a Windows NT server, there is usually an icon on the desktop that can be used to start the Network Station Manager.

A.7.2 Configuration of the Domain Name Server Data

Use the IBM Network Station Manager to ensure that your domain name server (DNS) information is properly configured.

This is required so that the Network Station has proper access back to its server but also for applications such as the browser to be able to properly resolve addresses both on the intranet and the Internet.
1. Start the Network Station Manager and log on as an administrator.

2. On the main Network Station Manager panel, in the Setup tasks on the left, select **Hardware => Workstations => System Defaults**, then scroll down to **Domain Name Server** and select an entry as illustrated below:

<table>
<thead>
<tr>
<th>Domain Name Server:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain name server to use:</td>
</tr>
<tr>
<td>☑ DNS Configuration from BOOTP or DHCP server</td>
</tr>
<tr>
<td>☑ DNS Configuration created by Network Station Manager</td>
</tr>
<tr>
<td>✔ Update Network Station Manager DNS file</td>
</tr>
</tbody>
</table>

Figure 130. DNS Configuration in IBM Network Station Manager

With this configuration item, you are actually selecting the source from which the Network Station gets its domain name server configuration information, which consists of:

- The IP address of a domain name server (or servers)
- The default IP domain name

The source of this information can be either:

- A DHCP server
- A configuration file called hosts.nsm created by the Network Station Manager on the server and downloaded to the station during the boot process.

This is illustrated in the next figure:
3. If your IBM Network Station is booting using a DHCP server, then in Figure 130 on page 145, select the first entry labeled **DNS Configuration from BOOTP or DHCP server**. Normally, the network administrator would have configured the DNS configuration data in the DHCP server as data to be transmitted to the station when it boots.

**Note:** It is possible to boot a station using DHCP and transmit the proper IP address that the station should use, and the address of the server that it should contact, but to omit the DNS configuration data. This would be unusual, but in that case, the second entry should be selected even though you are booting using DHCP.

4. If you are not using DHCP to boot the Network Station, then in Figure 130 on page 145, select the second entry labeled **DNS Configuration created by Network Station Manager**. In this case, the Network Station Manager copies the DNS configuration from the server configuration file into a file called hosts.nsm, which is downloaded by the Network Station during the boot process.

This step ensures that the IBM Network Station, once it is operational, knows which domain name server (DNS) to access in order to resolve IP host names into IP addresses.

If the Network Station is located on a network inside a corporation (intranet) and the browser is used to access URLs that are outside the company’s network
through a firewall, then an additional step required is the configuration of a proxy server for the browser application. See A.9.1, “Customizing the Browser Task” on page 159 for an example.

For additional details on this topic, please see 6.1, “Troubleshooting Domain Name Server Configuration” on page 119.

A.7.3 Configuring the Desktop in IBM Network Station Manager

This activity lets you specify which IBM Network Station users have the Lotus eSuite Workplace desktop configured as their default desktop when they log on to their IBM Network Station.

Use the IBM Network Station Manager application to define the default desktop settings for members of the group we defined earlier as the esuite group.

In NSM, select **Startup**=>**Menus**=>**Group Defaults**, enter the name esuite as the group name (or use Browse to select the group name from a list), as illustrated below, and click **Next** to continue.

![Figure 132. Setting Group Defaults](image)

In the Desktop and Menu Bar Options, the choices are as illustrated below:
Select the **Lotus eSuite WorkPlace with menu bar** option. This means that any user that is a member of the esuite group gets by default, at logon, the eSuite desktop automatically started on his or her Network Station.

### A.7.4 Defining a Time Zone Environment Variable

We also need to define an environment variable for the time zone. To do so, in the NSM Setup Tasks on the left, select **Startup => Environment Variables => Group Defaults**, enter `esuite` as the group name, and click on **Next**.

On the next panel, enter the variable name `TZ` (for time zone) and enter the value appropriate to your location.

In our example here, we used the Eastern Standard Time (EST) zone.
A.7.5 Selecting a User’s Group for eSuite Users

Even though we previously made our two sample users, Thomas and Ariane, members of the esuite group on the server, we still need to indicate to Network Station Manager the name of the group from which these users should inherit settings.

In other words, these two users inherit the settings that are made at the system level and at the individual user levels in NSM, but we can also indicate a group from which they can inherit settings. Since we have configured all eSuite-related settings in a group called esuite, we need to tell NSM to associate these two users with the esuite group.

Even though a user can belong to more than one group at the server level, that user can only inherit settings from one group in NSM.

To do this, select the Select User’s Group task in the NSM Setup Tasks list, and use the Browse button to display all the user names that are defined in the Windows NT User Manager for Domain definitions.
For which user do you want to select a group?

In the Select a user list, we choose Ariane for example, and choose Select and Return, and then Next, which brings up the next panel.

In the panel above, we choose the esuite group from which our user Ariane will inherit settings.

We repeat the procedure for user Thomas.
A.8 Configuring eSuite 1.0 Using the eSuite WorkPlace Administrator

The last set of configuration tasks to be accomplished is to use the eSuite WorkPlace Administrator on the server in order to:

1. Define eSuite users and/or eSuite groups in the eSuite Registry
2. Customize some application settings, such as proxy servers for the Web browser or mail server configuration

These configuration tasks require an additional administrator interface, different from the IBM Network Station Manager, called the eSuite WorkPlace Administrator.

The diagram below attempts to summarize some of the major components and positions the WorkPlace Administrator relative to the Network Station Manager.

Figure 138. The eSuite WorkPlace Administrator and Network Station Manager

The eSuite WorkPlace Administrator is used to update the eSuite Registry, which is the configuration file containing eSuite user, eSuite group and eSuite application configuration data for the eSuite WorkPlace desktops. These users, groups and applications are different from the Network Station user groups and applications.

The Network Station Manager on the other hand operates on configuration data related to Network Station users and applications, irrespective of whether these Network Station users are eSuite users or not. Network Station Manager also controls all the hardware configuration data pertinent to the Network Stations,
whereas the eSuite Workplace Administrator is only concerned with the eSuite applications configuration data.

A.8.1 Starting the eSuite WorkPlace Administrator 1.0

The eSuite WorkPlace Administrator comes pre-configured with one user name that has the required authority to log on and use the WorkPlace Administrator. This user name is called admin, and must be defined first as a user on the server before it can be used to log on for the first time to the WorkPlace Administrator. This is why we defined this user earlier on in this example.

The WorkPlace Administrator is started directly from the server, by logging on to the server as user admin and using the ewadmin command on the server.

Notes:

1. On Windows NT, the ewadmin command is located in \nstation\prodbase\esuite.
2. On AIX, run the /etc/ewadmin script.
3. On AS/400 and S/390, the eSuite WorkPlace Administrator is not accessed directly from the server but rather from an eSuite task on the Network Station’s eSuite WorkPlace desktop.

After ensuring that the RMI and eSuite registry servers are running on the server, log on to the IBM Network Station as user admin, and when the eSuite WorkPlace desktop appears, select the WorkPlace Administrator task in the Administration category.

In Windows NT and AIX, an alternate method to accessing the WorkPlace Administrator using the ewadmin command on the server is to log on to a Network Station and from the Network Station’s eSuite desktop, use the WorkPlace Administrator task.

If you choose to access the WorkPlace Administrator from a Network Station, remember that the user called admin must have been made part of the NSMuser group in order to able to log in to a Network Station.

The ewadmin command is in fact a BAT file used to start the WorkPlace Administrator Graphical Interface because the classpath is very long, as can be seen in the next figure.

Note: As an alternative to logging on to the server as user admin, you can also use the command: ewadmin -user admin.
D:\>cd \nstation\prodbase\esuite

D:\nstation\PRODBASE\esuite>ewadmin
ECHO is off.
d:\jdk1.1.5\bin\java -classpath .;d:\jdk1.1.5\lib\classes.zip;d:\nstation\Prodbase\esuite\esuite\com\lotus\jars\hotjava.jar;d:\nstation\Prodbase\esuite\com\lotus\jars\swing.jar;d:\nstation\Prodbase\esuite\com\lotus\jars\organic.jar;d:\nstation\Prodbase\esuite\com\lotus\jars\motif.jar;d:\nstation\Prodbase\esuite\com\lotus\jars\windows.jar -Duser.home=d:\nstation\Prodbase\esuite\lib\hotjava -Dhelp.files.home=file:///localhost/d:\nstation\Prodbase\esuite\com\lotus\server\help/en/ -DStartup.Root=file:/d:\nstation\Prodbase\esuite\com\lotus\server\admin\com.lotus.server.admin.NCAAdmin [Loading: C:\WTSRV\Profiles\admin\hotjava\urlpool]

Figure 139. Starting the eSuite WorkPlace Administrator

A small logo appears indicating that the application is starting:

![Lotus eSuite WorkPlace Administrator](image)

Figure 140. Lotus eSuite WorkPlace Administrator Starting

Then the main configuration panel is displayed, as shown below.
A.8.2 Giving WorkPlace Administrator 1.0 Access to Other Users

Notice in the panel above, the check mark labeled Administrator access. For each user listed in the list labeled Users: on the left side of the panel, you can set this check mark to indicate that this specific user can now function as an administrator for the eSuite WorkPlace Administrator, in addition to the default admin user.

A.8.3 Adding Users to the Lotus eSuite WorkPlace Administrator

Any user of the Lotus eSuite WorkPlace Desktop must first be added to the eSuite Registry in order to be allowed to use the desktop. The only exception is the user called admin, which has been added by default to permit an initial use of the WorkPlace desktop by an Administrator.

Users need to be added because the eSuite desktop can be customized for each user, in terms of the application categories and tasks that appear on the user’s desktop, and each user must therefore be identified in the eSuite Registry.

This cannot be done in the IBM Network Station Manager application because it is unaware of the eSuite application settings.
To add our Ariane and Thomas eSuite users, click on the Add button at the bottom of the Users list on the left-hand side of the panel.

This brings up a small panel, such as the one illustrated below, where you can enter the user ID that was defined in the Windows NT server, and you can use any user name if you want to identify this user by a name different than the user ID.

Be aware that the name that appears in the Users list however is the user name, not the user ID, unless you leave the user name blank, in which case the user ID is used also as user name.

![Add User dialog box](image)

**Figure 142. Adding a User to eSuite WorkPlace Administrator**

**Note:** Do not worry at this time about defining groups in the WorkPlace Administrator because you do not need this to become operational. The user you add is automatically made part of a group called All Users, which is all you need at this time.

This completes what needs to be done to be up and operational with the eSuite WorkPlace on a Network Station. However, dependent on which application is used by the user, a few of these applications, or eSuite tasks, may need to be customized first before they can be used.

### A.9 Customizing Applications in eSuite WorkPlace 1.0

After configuring using the Network Station Manager and the eSuite WorkPlace Administrator, the eSuite WorkPlace can be successfully started on a Network Station and most applications can be used without any additional configuration steps.

However, there are a few applications that require customization before they can be used. In other words, all applications are available for selection by the user on the eSuite desktop, but some of them are not functional without a few more customization steps. For example:

- The Mail task simply cannot be used without configuring a mail server. This can be done in advance by the administrator or it can be done by the user when he or she gets prompted the first time that he or she starts the mail application.
- The Web Browser task can be used if it does not require any proxy server to access the desired URLs. For access to the Internet using proxies, the proxies need to be specified.
• The Address Book task can be used as is. However, if access to address books other than a personal address book is required, the Light Directory Access Protocol (LDAP) must be customize to specify an LDAP server.

• Finally, if one desires to change the default file names used to store the user’s personal address book data, the calendar events and meetings, these names can optionally be changed to a name chosen by the user.

To customize these applications, on the main WorkPlace Administrator panel, select the Group icon on the main panel, and then the All Users (Default) group in the list of groups and click on Customize Software at the bottom right-hand corner of the main panel, which brings up the following selection panel:

![Customize Software for Group "All Users (Default)"

Notice the title of the panel which states that this is to customize software for the group called All Users. Software can also be customized at an individual user’s level if desired.

In the panel above, there are five entries that are selectable for customization. The diagram in the next figure summarizes what these five customization selections actually consist of.
Referring to the above diagram, under Software to customize, the entries called messageSourceMgr, addressSourceMgr and eventSourceMgr, when selected, allow you to change the name of the file used to store the meetings data, address book entries and calendar events, respectively.

As identified above, these files reside on the boot server in the user’s home directory located in ..\\nstation\userbase\home\"username"\, and the file names shown here as addressdef.kox, eventdef.kox and msgdef.kox are the default file names used.

The next figure shows these files as they appear in the user’s home directory on the boot server.
The following three figures illustrate the panels that are displayed when you click on the **Customize** button for any of these three entries.

**Figure 145. The User’s Home Directory**

**Figure 146. The MessageSourceMgr Customization Panel**

**Figure 147. The eventSourceMgr Customization Panel**
In Figure 144 on page 157, the LDAPSource Manager customization basically identifies where the LDAP server is located so that the Address Book task can establish a session with that server.

Finally, the MailSessionManager customization basically identifies where the incoming mail server and outgoing mail servers are as well as the protocol to be used with these servers.

Let us take a specific look now at some of these customization tasks.

A.9.1 Customizing the Browser Task

To provide an example of application customization, let us assume that in our example, we want to set the Web browser proxy settings for all users.

To set proxy servers for all users, select, on the eSuite WorkPlace Administrator's main panel, on the left-hand side, the icon labeled Groups, which displays a panel such as the one illustrated below:

![Customize Software for Group “All Users (Default)”](image)

In Figure 148, The addressSourceMgr Customization Panel

Figure 148. The addressSourceMgr Customization Panel
On this panel, select a group (the All Users group is already selected by default at this time) and in the bottom right-hand corner, click on the **Customize WorkPlace** button to bring up the next panel:
On this panel, put a check mark in the Connect through proxy server check box.

This opens up the FTP, Gopher and HTTP fields in which you can enter the name of a proxy host and the port to use on that host.

In our example, we used proxysrv.raleigh.ibm.com and port 80.

A proxy is required when your company’s network is isolated from the Internet by a firewall and you need to provide your users access to the outside world while shielding them from that world. That is done by a proxy server which in fact acts on your behalf to access outside resources.

This is illustrated in a simplified fashion in the next figure, where the eSuite browser user in the bottom left-hand corner of the diagram, when accessing the your.company.com server on the intranet, can have a direct session with that server since it is inside the company.

However, when the eSuite user wants to access the www.abc.com server, it cannot do so directly because that server is outside the company’s network. In that case, we specify that the browser should use a proxy, and give the address of the proxy.server machine as the proxy machine.

The request goes from the eSuite user to the proxy machine, which terminates the user session in the proxy.server machine; the proxy server then establishes its own session with the www.abc.com server, and acts as a go-between for the duration of the session. The www.abc.com is only aware of the proxy.server machine and not of the eSuite user machine.
Note: The eSuite browser application is not socksified which is why it does not have an entry field for a Socks host as you have normally on a Netscape browser for example. Therefore, it uses proxies for the HTTP, FTP and Gopher protocols.

Notice on the panel in Figure 150 on page 161 that there is an entry on the right-hand side labeled Search Engine, where http://www.altavista.digital.com/ is specified. This specifies the default search engine to use on the Web when the user chooses the Search the Web task. If a different search engine is desired, change this entry to a different URL such as www.yahoo.com for example.

A.9.2 Customizing the Mail Task

The customization procedure for the Mail task is the same as for eSuite 1.5 so we have not duplicated these instructions here. See 4.3, “Customizing the Mail Task” on page 58 for an example.

A.9.3 Customizing LDAP

This task is also similar to eSuite 1.5 so please refer to 4.4, “Customizing LDAP” on page 67 for an example.
Appendix B. Lotus eSuite Application Services Readme

We have reproduced here parts of the readme file available with the eSuite Application Services product in order to make you aware of some of the limitations.

If you are indeed installing this product, please refer to the full and latest readme available with the product before proceeding with the installation.

B.1 Lotus eSuite 1.5 Application Services Release Notes

Lotus eSuite 1.5 Application Services is technology that provides file viewing, file conversion and spell check to Lotus eSuite WorkPlace. Please read the information below before beginning the installation.

B.1.1 Server Installation Issues

Be aware of the following issues:

1. The server software cannot be installed on a server that has a previous installation of Lotus SmartSuite. It will attempt to uninstall the previous version of SmartSuite, however, this will only function properly with SmartSuite Release 9. If a previous version of SmartSuite (96 or 97) is installed on the server, you must manually run SmartSuite uninstall and manually remove the \lotus directory structure before installing Application Services. If you are removing SmartSuite 96, the program is located in the \lotsuite directory by default.

   **Note:** Deleting the contents of the \lotus directory on a server that also runs Lotus Notes or Domino could cause these programs to not run properly.

2. The installation will fail using leading spaces in your directory path. While these are legal characters, they cause problems in various places in Windows NT.

B.1.2 Known Limitations

The following are known limitations:

1. Opening Quattro Pro and some Excel files leaves .log files on the server. A work around this is to delete .log files from the \system\temp directory.

2. 123 service provider may stop with an error in low memory conditions.

3. If you do not shut down the factory before shutting down the Windows NT server, a Word Pro dialog box may be displayed on the server if a user is currently viewing a word processing document.

B.2 Summary: Installing eSuite Application Services

The installation process for Lotus eSuite Application Services consists of three tasks, performed in the following order:

1. Preconfiguring a Windows NT server before installing eSuite Application Services

2. Installing eSuite Application Services on the Windows NT server
3. Customizing eSuite to use eSuite Application Services

B.2.1 Task 1: Preconfiguring a Windows NT Server

eSuite Application Services consists of a variety of software that must be installed on a Windows NT server. Before you install the eSuite Application Services software on the Windows NT server, do the following:

- Verify your Windows NT server configuration. The following is the recommended minimum configuration:
  - Windows NT Server 4.0 (with service pack 3)
  - Pentium 200MHz processor or compatible
  - 128MB RAM
  - 2GB hard drive a minimum of 200MB of free space
  - 256-color video adapter
- Do not install eSuite Application Services and Lotus SmartSuite applications on the same machine.
- If a version of SmartSuite is already installed, the eSuite Application Services installation program will uninstall it before installing the eSuite Application Services software.
- Make sure that you do not intend to install SmartSuite on this server after you install the eSuite Application Services software.
- Specify a static IP address for the Windows NT server machine.

Note: Do not use the DHCP protocol to assign the address.

- Make sure that prior to installing the eSuite Application Services software, you log on to the Windows NT server as a user with administrator privileges. If you need to, create a user account with these privileges and log on as this user prior to installation. You will always need to log on as this user in order to run the eSuite Application Services. If the Windows NT server is the same machine as your eSuite Registry server, you must log on with administrator rights to the eSuite Registry Server.
- Log on as the user account you created above and connect the server to one or more of your network printers, including eSuite WorkPlace client machine printers, so that users can print the files they view in the eSuite viewer application.
- Disable Notify when printed in the Gateway Server for NetWare (GSNW) panel on the Windows NT Control Panel.

B.2.2 Task 2: Installing the eSuite Application Services Software

The eSuite Application Services software consists of the following pieces:

- eSuite service provider software. eSuite service providers implement the ability to view and work with non-eSuite spreadsheet and word processor files using eSuite viewer, as well as provide spell checking for eSuite applications.
- eSuite Factory software (EASFACTR.EXE). The Factory dispatches requests for services to the appropriate service provider.
- eSuite Factory startup program (EASSTART.EXE). The Factory startup program initiates the Factory software.
**Important:** Before you install the eSuite Application Services software, read the information on preconfiguring the Windows NT server.

To install the eSuite Application Services software on the Windows NT server, do the following:

1. If you haven’t already done so, log on to the Windows NT server as a user with administrator privileges. If the Windows NT server is the same machine as your eSuite Registry server, log on with the user name admin, which has all of these privileges.

   **Important:** Make note of the user name you use to install the eSuite Application Services software. After you install the eSuite Application Services, to start up the Factory software, you must log on to the Windows NT server as the same user who installed the software every time you reboot or turn on the Windows NT server. Note that logging off shuts down the Factory software and thus terminates the viewing and spell checking services.

2. Shut down all programs currently running. Some of them may use .DLL files that will be replaced when the eSuite Application Services software is installed, so terminating these programs ensures a successful installation process.

   If the Windows NT server is the same machine as your eSuite Registry server, do not shut down the Lotus eSuite Services console.

3. Run the file INSTALL.EXE from Windows Explorer or from an NT console window to begin the installation process.

4. Specify the installation drive and directory for the eSuite Application Services software and click **OK**. This copies the eSuite Application Services files to the drive and directory you specified and updates the registry.

   The default directory is **c:\lotus**.

5. After the eSuite Application Services software installation program runs, specify the directory where you want to place ESUITEFACTORY.IOR, the CORBA IOR file. This file contains the interoperable object reference (IOR) address of the eSuite Application Services software you just installed on the Windows NT server. You will have to specify the name and location of this file later when you customize the eSuite WorkPlace to point to the address of the Windows NT server.

   **Note:** If you installed the eSuite Application Services software to the default directory in step 3, the default location for the CORBA IOR file is **c:\lotus\eServer**.

   If the Registry server and eSuite Application Services are on separate machines that do not use the same file system, we recommend that you do one of the following:

   - Copy ESUITEFACTORY.IOR to a diskette so that you can reference the file from a disk drive on the Registry server.
   - Share the folder on the machine where you installed the eSuite Application Services software. Then on the machine where the Registry server is installed, map a drive to that folder, so that you can easily point to the IOR file.
   - Use FTP to transfer ESUITEFACTORY.IOR to the location where the WorkPlace applets reside.
When you finish installing the eSuite Applications Services software, you may be asked to reboot your machine.

**B.2.3 Task 3: Customizing eSuite WorkPlace for Application Services**

The eSuite Application Services software provides eSuite WorkPlace with the ability to view and work with non-eSuite files as well as the ability to perform spell checking on eSuite files.

eSuite WorkPlace, which gets services from the eSuite Application Services software that you installed on the Windows NT server, is installed on the eSuite Registry server machine.

Customizing the WorkPlace means that you are telling it where the CORBA IOR file is, so that the WorkPlace can use the IOR address in the file to connect to the eSuite Application Services software.

Note the following issues about customizing the WorkPlace:

- Make sure eSuite WorkPlace 1.5 is already installed.
- The eSuite Registry server and the Windows NT server where the eSuite Application Services software resides can be the same machine.

To customize the WorkPlace on the Registry server, perform the following steps:

1. Do one of the following:
   - If the Registry server is on an NT server, click the eSuite WorkPlace Administrator icon.
   - If you are customizing the software from the client software (you must have administrator rights), start the WorkPlace Administrator from the eSuite WorkPlace desktop.

2. Click the **Software** panel.

3. Click **Group Defaults** at the bottom of the panel.

4. Under Select a group, click and select all the specific user groups that you would like to have utilize the Application Services software. (See the eSuite Workplace documentation for instructions on setting up user groups.)

5. Under Software to customize, click **ApplicationServicesManager**.

6. Click **Customize**.

7. Type the directory and name of the CORBA IOR file created during task 2.

   Specifying the CORBA IOR file identifies the eSuite Application Services machine for the selected users. This allows selected users to access services that are available from the eSuite Application Services software.

   **NT users**

   If the Registry server and the eSuite Application Services software are installed on the same machine and if you installed the eSuite Application Services software to the default directory on the Windows NT server, type the name and location:

   `c:\lotus\eserver\esuitefactory.ior`
If you copied this file to a diskette when you installed the eSuite Application Services software, insert the diskette in the disk drive of the Registry server machine and type the name and location:

a:\esuitefactory.ior

If the file is on a shared drive on the machine where you installed the eSuite Application Services, map to that drive, and then type the name and location of the file on that drive.

**AIX users**

Copy the IOR file (eSuiteFactory.ior) to /usr/netstation/eSuite, the location where the WorkPlace applets reside. Make sure all users have read/write access to ESUITEFACTORY.IOR

Then type the file name and location exactly as it appears here (lowercase e, capital S, capital F):

file:///usr/netstation/eSuite/eSuiteFactory.ior

8. Click **OK**.

9. Click **OK** again in the confirmation window that is displayed.

10. Click **Done**.

11. Click **Exit** to close the eSuite WorkPlace Administrator.

   The eSuite Application Services installation is now complete.

**Important**: If you do any of the following, you must recustomize the eSuite WorkPlace.

- **Change the IP address of the Windows NT server machine where the eSuite Application Services software is installed.**

  When you do this, you must regenerate the IOR file for the eSuite Application Services because the address of the application has changed with the new IP address. To do this, you must run the eSuite Application Services software to generate this new IOR. On the NT Start menu, choose **Run** and type:

  c:\lotus\eserver\easstart -w

  If you did not install to the default directory, then substitute the appropriate path for c:\lotus. Then use the IOR file generated by this procedure and follow the instructions for Customizing eSuite WorkPlace to use eSuite Application Services.

- **Decide to set up a different Windows NT server as the eSuite Application Services server.**

  Follow the instructions for installing the eSuite Application Services software on the new server, then use the CORBA IOR file generated by this new installation to follow the instructions again for customizing eSuite WorkPlace to use eSuite Application Services.

- **Decide to use a different Windows NT server, which already has the eSuite Application Services software installed, as the eSuite Application Services server.**

  Locate the CORBA IOR file on this server, which was generated when the eSuite Application Services software was installed. The default name and location of this file are c:\\lotus\\eserver\\esuitefactory.ior. Copy this file to a
diskette and then follow the instructions again for customizing eSuite
WorkPlace to use eSuite Application Services.

- Reinstall the eSuite Application Services software.

Follow the instructions again for installing the eSuite Application Services
software, then use the CORBA IOR file generated by this new installation to
follow the instructions again for customizing eSuite WorkPlace to use eSuite
Application Services.

**Note:** You may install the eSuite Application Services software on more than one
machine, carefully saving the IOR files from each installation. Using the
WorkPlace Administrator tool, you can then connect different user groups to
different eSuite Application Services machines by repeating steps 4 through 9
above.

The actual readme file has additional information on system maintenance,
uninstalling, shutting down and restarting, managing resources and
troubleshooting, so we encourage you to reference the full readme file.

This summary was reproduced only to give you an idea of some of the steps
required.
Appendix C. Special Notices

This publication is intended to help users install and customize the Lotus eSuite WorkPlace Release 1.5 on a Network Station Manager Release 3.1 server. The information in this publication is not intended as the specification of any programming interfaces that are provided by the Lotus eSuite WorkPlace. See the PUBLICATIONS section of the IBM Programming Announcement for Lotus eSuite WorkPlace for more information about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for convenience only and do not in any manner serve as an endorsement of these Web sites.

The following document contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples contain the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.
The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:

<table>
<thead>
<tr>
<th>IBM ®</th>
<th>AIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS/400</td>
<td>MVS/ESA</td>
</tr>
<tr>
<td>OS/390</td>
<td>OS/400</td>
</tr>
<tr>
<td>RS/6000</td>
<td>S/390</td>
</tr>
<tr>
<td>System/390</td>
<td>VM/ESA</td>
</tr>
</tbody>
</table>

The following terms are trademarks of other companies:

C-bus is a trademark of Corollary, Inc.

Java and HotJava are trademarks of Sun Microsystems, Incorporated.

Microsoft, Windows, Windows NT, and the Windows 95 logo are trademarks or registered trademarks of Microsoft Corporation.

PC Direct is a trademark of Ziff Communications Company and is used by IBM Corporation under license.

Pentium, MMX, ProShare, LANDesk, and ActionMedia are trademarks or registered trademarks of Intel Corporation in the U.S. and other countries.

UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.

Other company, product, and service names may be trademarks or service marks of others.
Appendix D. Related Publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

D.1 International Technical Support Organization Publications

For information on ordering these ITSO publications see “How to Get ITSO Redbooks” on page 173.

- S/390 - IBM Network Station - Getting Started, SG24-4954
- AS/400 - IBM Network Station - Getting Started, SG24-2153
- IBM Network Station Guide for Windows NT, SG24-2127
- IBM Network Station Manager Release 3 Guide for Windows NT, SG24-5221
- IBM Network Station - RS/6000 Notebook, SG24-2016

D.2 Redbooks on CD-ROMs

Redbooks are also available on CD-ROMs. Order a subscription and receive updates 2-4 times a year at significant savings.

<table>
<thead>
<tr>
<th>CD-ROM Title</th>
<th>Subscription Number</th>
<th>Collection Kit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>System/390 Redbooks Collection</td>
<td>SBOF-7201</td>
<td>SK2T-2177</td>
</tr>
<tr>
<td>Networking and Systems Management Redbooks Collection</td>
<td>SBOF-7370</td>
<td>SK2T-6022</td>
</tr>
<tr>
<td>Transaction Processing and Data Management Redbook</td>
<td>SBOF-7240</td>
<td>SK2T-8038</td>
</tr>
<tr>
<td>Lotus Redbooks Collection</td>
<td>SBOF-6899</td>
<td>SK2T-8039</td>
</tr>
<tr>
<td>Tivoli Redbooks Collection</td>
<td>SBOF-6898</td>
<td>SK2T-8044</td>
</tr>
<tr>
<td>AS/400 Redbooks Collection</td>
<td>SBOF-7270</td>
<td>SK2T-2849</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (HTML, BkMgr)</td>
<td>SBOF-7230</td>
<td>SK2T-8040</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (PostScript)</td>
<td>SBOF-7205</td>
<td>SK2T-8041</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (PDF Format)</td>
<td>SBOF-8700</td>
<td>SK2T-8043</td>
</tr>
<tr>
<td>Application Development Redbooks Collection</td>
<td>SBOF-7290</td>
<td>SK2T-8037</td>
</tr>
</tbody>
</table>

D.3 Other Publications

These publications are also relevant as further information sources:

- IBM Network Station Manager Installation and Use, SC41-0664
- OS/400 Work Management, SC41-5306
How to Get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, CD-ROMs, workshops, and residencies. A form for ordering books and CD-ROMs is also provided.

This information was current at the time of publication, but is continually subject to change. The latest information may be found at http://www.redbooks.ibm.com/.

How IBM Employees Can Get ITSO Redbooks

Employees may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **Redbooks Web Site on the World Wide Web**
  

- **PUBORDER** – to order hardcopies in the United States

- **Tools Disks**
  
  To get LIST3820s of redbooks, type one of the following commands:

  TOOLCAT REDPRINT
  TOOLS SENDTO EUHONE4 TOOLS2 REDPRINT GET SG24xxxxx PACKAGE
  TOOLS SENDTO CANVM2 TOOLS REDPRINT GET SG24xxxxx PACKAGE (Canadian users only)

  To get BookManager BOOKs of redbooks, type the following command:

  TOOLCAT REDBOOKS

  To get lists of redbooks, type the following command:

  TOOLS SENDTO UDIST MKTOOLS MKTOOLS GET ITSOCAT TXT

  To register for information on workshops, residencies, and redbooks, type the following command:

  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ITSOREGI 1998

- **REDBOOKS Category on INEWS**

- **Online** – send orders to: USIB6FPL at IBMMAIL or DKIBMBSH at IBMMAIL

---

**Redpieces**

For information so current it is still in the process of being written, look at “Redpieces” on the Redbooks Web Site ([http://www.redbooks.ibm.com/redpieces.html](http://www.redbooks.ibm.com/redpieces.html)). Redpieces are redbooks in progress; not all redbooks become redpieces, and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.
How Customers Can Get ITSO Redbooks

Customers may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **Online Orders** – send orders to:
  - In United States: usib6fpl at ibmmail
  - In Canada: caibmbkz at ibmmail
  - Outside North America: dkibmbsh at ibmmail

- **Telephone Orders**
  - United States (toll free): 1-800-879-2755
  - Canada (toll free): 1-800-IBM-4YOU
  - Outside North America: (long distance charges apply)
    - (+45) 4810-1320 - Danish
    - (+45) 4810-1420 - Dutch
    - (+45) 4810-1540 - English
    - (+45) 4810-1670 - Finnish
    - (+45) 4810-1220 - French
    - (+45) 4810-1020 - German
    - (+45) 4810-1270 - Norwegian
    - (+45) 4810-1120 - Spanish
    - (+45) 4810-1170 - Swedish

- **Mail Orders** – send orders to:
  - IBM Publications
    - Customer Support: 144-4th Avenue, S.W.
    - P.O. Box 29570
    - Raleigh, NC 27626-0570
    - USA
  - IBM Direct Services
    - 144-4th Avenue, S.W.
    - Calgary, Alberta T2P 3N5
    - DK-3450 Allerød
    - IBM Publications
    - 144-4th Avenue, S.W.
    - Calgary, Alberta T2P 3N5
    - DK-3450 Allerød
    - IBM Direct Services
    - Sortemosevej 21

- **Fax** – send orders to:
  - United States (toll free): 1-800-445-9269
  - Canada: 1-800-267-4455
  - Outside North America: (+45) 48 14 2207 (long distance charge)

- **1-800-IBM-4FAX (United States) or (+1) 408 256 5422 (Outside USA)** – ask for:
  - Index # 4421 Abstracts of new redbooks
  - Index # 4422 IBM redbooks
  - Index # 4420 Redbooks for last six months

- **On the World Wide Web**
  - Redbooks Web Site: http://www.redbooks.ibm.com

---

**Redpieces**

For information so current it is still in the process of being written, look at "Redpieces" on the Redbooks Web Site (http://www.redbooks.ibm.com/redpieces.html). Redpieces are redbooks in progress; not all redbooks become redpieces, and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.
IBM Redbook Order Form

Please send me the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Order Number</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

First name       Last name

Company

Address

City                               Postal code                               Country

Telephone number                               Telefax number                               VAT number

☐ Invoice to customer number

☐ Credit card number

Credit card expiration date                               Card issued to                               Signature

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not available in all countries. Signature mandatory for credit card payment.
Index

A
actlogin 29, 101
add a Network Station native application 77
Adding
   individual users to eSuite 42
   Java Applet Task 90
   lock screen task 77
   new software 77
   new task 72, 80
   Telnet task 87
   user to a group 14
   users to eSuite 42
   users to eSuite - Release 1.0 154
Address Book Task 112
Adjust to local time 30
admin user 13
Administrator
   eSuite Release 1.0 151
   eSuite Release 1.5 34
Administrator Access 40
AIX Prerequisites
   eSuite Release 1.0 140
   eSuite Release 1.5 17
Application Services
   customizing 93
   installation 93
   summary 3
   what is 163
ApplicationServicesManager 95
AS/400
   manual configuration 16
   server prerequisites 15
   server prerequisites - Release1.0 138
Assigning
   task to a Category 82
   task to a user 75
   task to groups and users 84
   audience - target 1
Authentication server 49
Automated installation 10
autolog 9

B
Batch installation 10
boot server 49
Browser
   customizing 55
   customizing - Release 1.0 159
   prerequisite 7

C
Calculating Tasks 109
Calendar Task 108
categories - eSuite tasks 103
category - Network Station 117
Certificate 41
Clipboard 3
Colors - eSuite 31
Configuration using NSM - Release 1.0 144
console - network station - starting 102
Create a New Group on the Server 13
Create a User on the server 13
Customizing
   browser task 55
   eSuite Application Services 93
   LDAP 67
   mail task 58
   Network Station native applications 71
Cut and Paste 3

default domain name 120
Desktop configuration in NSM 27
Desktop controls 104
Desktop example - eSuite 103
desktop settings 27
DESKTOP_HOME 12
DHCP
   configuration file 121
   DNS configuration 121
Displaying DNS Information - Network Station 125
Displaying the IP Routing Table 125
DNS
   configuration 25
   configuration on the Network Station 123
   configuration on the server 119
Domain Name Server - prerequisite 7
Domain Name Server configuration 25
Domino Go 4.6.2 8
Duser.home.server parameter 49
enhancements - Release 1.5 2
Environment Variable - eSuite 29
eSuite 7, 134
colors 31
   main Administrator configuration panel 39
   NT service 11
   Registry 34
   registry - starting - AS/400 17
   registry - starting - S/390 20
   sample desktop 103
   WorkPlace Administrator 34
   WorkPlace Administrator - Release 1.0 151
esuite.nsl configuration file 29, 49, 101
ESUITEFACTORY.IOR 165
ewadmin.bat 35
ile filter 3
file formats 3
file viewers 3
Installing and Customizing Lotus eSuite WorkPlace 1.5 for IBM Network Stations

G
GET ALL command 123
GET GROUPS command 123
GET TCPIP command 123
global group - NT 47
GMT time 30
group - NT - creating 14

H
hardware prerequisites 7
home directory 107
HOSTNAME 12
hosts.nsm configuration file 120

I
IMAP4 - mail protocol 59
import users 2
Importing users and groups to eSuite 43
install.txt 9
Installation
Application Services 93
batch 10
summary table - Release 1.0 131
summary table - Release 1.5 4
Installing
eSuite Application Services 163
on a S/390 Server 18
on a S/390 Server - Release 1.0 142
on an AIX Server 17
on an AIX Server - Release 1.0 140
on an AS/400 Server 15
on an AS/400 Server _Release 1.0 138
on Windows NT 9
on Windows NT - Release 1.0 135
IP domain name 120
IP host name 120
IP routing table 125

J
Java 11
Java applet task - adding 90
Java Security 40
JAVA_HOME variable 12
JDK 1.1.5 - eSuite - Release 1.0 135
JDK 1.1.6 8, 10

L
Limitation of the Import Users 46
loading time 102
local group - NT 47
local time 30
Lock Screen task - adding 77
Log in automatically 60
Login name 60
Lotus eSuite WorkPlace 2

Lotus eSuite Workplace Registry 11

M
mail task - customizing 58
mail user preferences 60
mailbox tasks 113
message log - sample 127
MetaFrame 2
Migration 11
Multiple servers 49
multiple users - assign NSM group 34

N
native X applications 3
Network Station DNS configuration 123
Network Station Manager - starting 25
Network Station native applications - using 117
non-eSuite files 3
NSMAdmin 13
NSMUser 13
NT services 11

O
OS/390 prerequisites - Release 1.0 142

P
password - configuration 123
ping - using 120
Points Mode - Presentation Graphics 3
POP3 - mail protocol 59
Prerequisites
AIX 17
AIX - Release 1.0 140
all platforms 7
all platforms (Release 1.0) 134
AS/400 15
OS/390 - Release 1.0 142
S/390 19
Windows NT - eSuite Release 1.0 134
Windows NT 8
Presenting Task 110
proxy - what is? 56
proxy configuration - eSuite 55
public password 123

R
readme files 7
Registry - eSuite 11
Release 1.0 131
response file 10
RMI Registry - starting - AS/400 17
RMI Registry - starting - S/390 20
root - user 35
routing table 125
S
S/390 Server Prerequisites 19
Sample IP Routing Table 126
Sample Message Logs 127
Search Engine 162
Search the Web 104
Security - Java 40
Select User’s Group 33
Set Task Properties 73
setup.exe - parameters 10
setup.iss 10
Skip mail login 60, 114
SMTP 59
spell checking 3
Spelling Dictionary 97
Start the 3270 Emulator 117
Starting
eSuite WorkPlace Administrator 35
eSuite WorkPlace Desktop 101
Network Station Manager 25
startup duration - eSuite desktop 102
startup.nsm 28
Summary of Installation 4
Summary of Installation - Release 1.0 131
synchronize users 2
Synchronizing Users and Groups 45
System information - mail task 115
System Variables 12

T
target audience 1
Telnet 123
Telnet task - adding 87
Test Network - Ping 120
Time Server 30
Time Zone 29
Troubleshooting AS/400 problems 126
TZ variable 29

U
undo 3
user preferences - mail task 114

V
Viewers 3

W
web server configuration 12
Web Task 104
What is
eSuite WorkPlace Administrator? 34
Lotus eSuite WorkPlace? 2
new in Release 1.5? 2
Windows NT Server Prerequisite 8
Windows NT Server Prerequisite - Release 1.0 134
WinFrame 2
Work Files tasks 106

WorkPlace Administrator 2, 34
access 40
Release 1.0 151
starting 35
Writing tasks 111

Y
Year 2000 3
ITSO Redbook Evaluation

Installing and Customizing Lotus eSuite WorkPlace 1.5 for IBM Network Stations
SG24-5307-00

Your feedback is very important to help us maintain the quality of ITSO redbooks. Please complete this questionnaire and return it using one of the following methods:

• Use the online evaluation form found at http://www.redbooks.ibm.com
• Fax this form to: USA International Access Code + 1 914 432 8264
• Send your comments in an Internet note to redbook@us.ibm.com

Which of the following best describes you?

_ Customer _ Business Partner _ Solution Developer _ IBM employee _ None of the above

Please rate your overall satisfaction with this book using the scale:

(1 = very good, 2 = good, 3 = average, 4 = poor, 5 = very poor)

Overall Satisfaction __________

Please answer the following questions:

Was this redbook published in time for your needs? Yes___ No___

If no, please explain:

____________________________________________________________________
____________________________________________________________________
____________________________________________________________________

What other redbooks would you like to see published?

____________________________________________________________________
____________________________________________________________________
____________________________________________________________________

Comments/Suggestions: (THANK YOU FOR YOUR FEEDBACK!)

____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________